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1 Introduction

Automatic IT discovery is the process of finding and identifying devices on a network. 

1.1 Starter Edition

Note that the feature-set is limited when using JDisc Discovery 's Essential Edition! The 
starter edition does not display all dialogues or reports described within this manual!

1.2 Discovery Product Categories

The network discovery product market is segmented into four product categories: 

1. Agent based

2. Zero-footprint

3. Passive 

4. Agent-less 

Products in these categories can create an inventory of devices on a network but follow 
different approaches. Products often implement techniques from theses categories.

1.3 Agent-based Products

Agent-based products require a proprietary data collection agent. Agents are small 
applications or scripts that are permanently installed and run as daemons on target 
computers. A central discovery or management application polls the data collection 
agent, collects inventory data, and finally stores inventory data in a database. The 
agent deployment can be either manual or automatic depending on the product.

The advantage of agent based discovery applications is that agents can collect virtually 
any kind of data on the target computer. Agents run locally on target computers and 
typically have full access to all system resources. By comparing current data with the 
last transmitted data, agents can minimize network utilization.
The disadvantage of agent-based systems is that many device types such as printers, 
routers, switches, etc. do not allow installing agents. Agent deployment can also be 
time consuming and might create security and performance risks unless thoroughly 
tested and well designed.
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1.4 Zero-Footprint Products

Zero-footprint products do not permanently deploy agents on target computers. In 
many cases they rely on running system commands on target devices. Sometimes they 
might also deploy their own scripts or binaries on target computers for the duration of 
the discovery. These scripts and binaries are deleted once the discovery has 
completed. Thus the target computer's configuration has not changed compared to the 
configuration before the scan. Similar to agent-based tools, zero-footprint products can 
collect virtually all kind of information. Zero footprint tools share some of the 
disadvantages of agent-based systems, such as possible security and performance 
risks. However, in most cases, system commands are powerful enough to retrieve all 
necessary information and no proprietary scripts or binaries are used at all.

1.5 Passive Discovery Products

Passive discovery products scan packets on the network. Network traffic can contain 
information about devices, their IP and MAC addresses, and sometimes information 
about running applications. Passive discovery products can create an inventory from 
information extracted from network packets that the discovery product receives.

The advantage of passive discovery products is the zero impact on the network. These 
products don't actively send network packets to target computers. However, since they 
rely on listening to network packets they'll not find devices that create minimal or zero 
network traffic. Moreover getting detailed device information is difficult if not impossible 
without sending packets to target devices.

1.6 Agent-less Products

Agent-less products (also called non-intrusive products) use only protocols that are 
available on target computers. Virtually every device on the network exposes some 
kind of protocol suitable to query basic configuration data. Some prominent examples 
for such protocols are SNMP, WMI, and WBEM.

Agent-less products can be easily deployed because they do not need to install 
proprietary agents on target computers. With a wide variety of protocols, they can get 
very detailed information.

However, as agent-less products are limited to standard protocols, they can only 
discover the information that the standard protocols expose. Furthermore (local) 
firewalls can prevent agents-less products to get detailed information from devices 
behind the firewall.

1.7 JDisc Discovery's Architecture

JDisc Discovery uses zero-footprint and agent-less technologies. It follows the client-
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server architecture. The user interface client communicates via RMI with the discovery 
server. The discovery server runs as a Windows service in the background. The user 
interface client and the discovery server might also be installed on different computers. 

The figure below illustrates JDisc Discovery's architecture.

Figure: JDisc Discovery architecture

The discovery server 

● hosts the discovery process

● prepares reports for user interface clients

● loads and stores the discovery configuration

● provides maintenance functionality such as archive/restore of the database

The user interface client

● interacts with the user

● sends user requests to the discovery server

1.8 Summary

JDisc Discovery is a client-server application and it's discovery is a combination of 
agent-less and zero-footprint products. 

The discovery process follows three concepts:

1. Finding active devices: JDisc Discovery uses a variety of protocols to find active 
devices on the network. ICMP-ping requests find devices in IP sub-networks or 
ranges. Windows domain discovery finds devices in NTLM domains. LDAP 
queries find devices in Microsoft Active Directory environments.

2. Identify devices: When JDisc Discovery has detected an active device, it 
attempts to identify it. Identifying a device means to query basic device 
information, such as manufacturer, model, and device type.

3. Collect data: JDisc Discovery performs further data collection once a device has 
been identified. This includes a variety of hardware, software and configuration 
information.

Discovering a device using JDisc Discovery includes identification 
and data collection. Other products might have a different definition 
of discovery. Be careful when comparing JDisc Discovery with 
similar products!
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2 Getting Started

2.1 Starting The User Interface

To start the JDisc Discovery client, click JDisc » JDisc Discovery 5.0 » JDisc Discovery 
from the Windows Start menu. JDisc Discovery uses Windows authentication. 

The JDisc Discovery client brings up the login dialog, which prompts for:

● The JDisc Discovery server to connect to

● The user name. JDisc Discovery uses Windows' built-in user authentication. The 
first user who logs on to JDisc Discovery becomes it's primary administrator. 
Note: JDisc Discovery's user management allows to administer users and user 
groups. 

● The user's Windows password

● The server's RMI port (default is 30470)

Use your Windows account to login for the first time. By default, JDisc Discovery 
suggests your current login name for the first login.

Figure: Login to the JDisc Discovery server.

Use your Windows account to log on for the first time. By default, JDisc Discovery 
suggests the interactive login name.

Note: The server's and client's RMI ports can be changed. Refer to 
the Administration Guide for more information.
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2.2 Understanding The User Interface

The user interface's main area displays status information. It shows information about 
discovery activity including devices currently being discovered, IP networks and ranges 
currently being pinged, Windows domains, and directory objects currently being 
discovered. The Discoveries tab lists all scheduled discoveries including their current 
status and schedule.

Figure: JDisc Discovery's main window

The menu provides eight items:

● File: Exit the application

● Discovery: Configure and manually start the discovery

● Devices: Various device reports

● Software: Various software related reports

● Networking: Various network reports

● User: Various user related reports

● Documents: Document management

● Troubleshooting: Various reports to troubleshoot the discovery result

● Administration: Several administrative tasks such as backup, clear, and restore 
the database

● Help: On line help, license status, and the About dialog
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2.3 Initial Configuration

During installation, JDisc Discovery's installation program detects and configures the 
local network. JDisc Discovery requires initial configuration information. Use JDisc 
Discovery's configuration wizard to create the initial configuration

Note: The configuration wizard does not cover all discovery 
configuration options. Use the Configuration menu item from the 
Discovery menu for detailed configuration.

Open the Configuration Wizard from the Discovery menu. 

Figure: Configuration Wizard

The configuration wizard will guide you through the initial configuration. The explanation 
section on the bottom of the dialog informs you about important aspects of the 
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configuration. The dialog covers:

● Discovery scope (networks, IP ranges, Windows domains, Microsoft Active 
Directory objects)

● Desired platforms (such as Windows, HP-UX, Linux, ...)

● Default access credentials for each platform

● Default SNMP communities and SNMPv3 accounts.

● Data items to discover (such as processors, memory modules, software, ...)

● Microsoft Active Directory access

Click Next to get to the first configuration screen.

2.3.1 Define The Discovery Algorithm For Finding New Devices

As a discovery product, JDisc Discovery's purpose is to find devices on the network. 
Depending on the purpose of the discovery exercise, a user might want to discover as 
many devices as possible or restrict the discovery to a well defined area. Answer the 
question with yes, if you would like to discover only a well defined part of your network. 
Answer with no to discover as many devices as possible.

Note: The discovery might also leave your company network, if it 
finds IP addresses outside the network in a device's ARP cache or 
in its IP connections.
Refer to chapter 5 to learn how to configure the discovery algorithm 
on a finer granularity.
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Figure: Configure how to find new devices

2.3.2 Select Major Platforms To Discover

JDisc Discovery can discover a variety of devices. Select the major platforms that are 
of interest for your project. The wizard will adjust the discovery configuration to get an 
optimal discovery result.

The Next button will skip the default accounts screen unless at least one Unix platform 
or Apple's Mac OS X is selected.

Figure: Select major Device Platforms

This dialog might vary depending on the licensed edition.

- 19 -



2.3.3 Configure Default Accounts For Unix And Mac OS X

JDisc Discovery discovers Unix computers by using remote login. It logs on via SSH or 
telnet, then it executes system commands, and parses the output to get detailed 
information about a Unix or Mac OS X computer. SSH and telnet require accounts to 
for a successful log-on. Use this screen to enter default accounts for the selected 
platforms.

Note: Be careful with adding too many default accounts. Testing 
many default accounts (especially with SSH) can cause intrusion 
detection alerts!
Use JDisc Discovery's grouping mechanism to define default 
accounts on a much finer granularity. Refer to section 3.3 for more 
details on how to group devices and networks.

Figure: Define Default Accounts
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This dialog might vary depending on the licensed edition.

2.3.4 Configure Default SNMP Credentials

JDisc Discovery uses SNMP to discover most network devices such as routers, 
switches, printers, and others. SNMP requires access credentials. For the protocol 
version 1 and version 2c, it requires a so called SNMP community which is basically a 
simple password. The factory default for most devices is 'public'. Therefore this account 
is pre-configured JDisc Discovery's discovery. Add new communities as needed. 
SNMPv3 was developed to overcome security problems1 with the protocol versions 1 
and 2c. Use the SNMPv3 configuration area to provide default SNMPv3 access 
credentials.

Figure: SNMP Community and Account Configuration

1 SNMPv1 and v2c transmit the community unencrypted string in clear text.
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2.3.5 Data Collection

JDisc Discovery collects hardware, software and configuration information from devices 
on the network. During discovery, JDisc Discovery sends to and receives data from 
devices being discovered. The data volume affects the network bandwidth that is 
utilized during discovery. The more information is collected, the more network 
bandwidth will be utilized.

The Data Collection dialog allows configuring data collection to fit to your needs. 
Enable or disable collection items as needed.

Depending on the license, some items might not be available in the 
user interface.

Figure: Data Collection Configuration

To reduce network utilization, limit the data collection to those items 
that are important for your!
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2.3.6 Configure Microsoft Active Directory Access

JDisc Discovery supports Microsoft Active Directory for discovery of devices that are 
member of a directory. A subset of directory objects will be synchronized with JDisc 
Discovery's database either on request or automatically when running a discovery 
cycle. Directory object types that can be synchronized include 

• DNS domains

• Organizational units

• Containers

• Computer accounts

• User groups

• Users

JDisc Discovery queries directory member computers of enabled directory objects 
using the Global Catalog (GC) service and also DNS domain controllers (DC) when 
discovering recently logged-on computers. The resulting DNS host names of member 
computers are looked-up and to IP addresses and are inserted into the device queue 
for discovery. 

Figure: Directory Access 

JDisc Discovery uses the Lightweight Directory Access Protocol (LDAP) to connect to 
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the Global Catalog (GC) service and also to DNS domain controllers (DC). The Global 
Catalog (GC) holds a subset replica of all directory objects across all DNS domains and 
trusted DNS domains.

You can configure access credentials to the Global Catalog (GC) and the Domain 
Controllers (DC) for each DNS Domain. JDisc Discovery uses these access credentials 
(service account) to synchronize directory objects but also to query directory member 
computers.

Select yes to configure Active Directory access or no, if Microsoft Active Directory is not 
installed on your network.

Configure at least one DNS domain controller / Global Catalog (GC) server for directory 
access and add login credentials to connect to the DNS domain controller. Click Test to 
test the configuration. Click Sync Networks to synchronize IP networks configured in 
the directory and Sync Directory to synchronize the directory with JDisc Discovery's 
database.

Click Test to check the DNS domain controller connection before 
moving on to the next dialog!

- 24 -



Figure: Active Directory Configuration

2.3.7 The Discovery Scope

The discovery scope, including

● IP4 networks

● IP4 address ranges

● Microsoft Windows network neighborhood objects

● Microsoft Active Directory objects

defines what JDisc Discovery is going to discover.

Figure: Define the Discovery Scope
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2.3.8 IP4 Networks And Ranges

On the IP4 Networks tab add, import or change the configuration of IP4 networks. 
JDisc Discovery only pings enabled networks (indicated by the check mark).

Add IP4 address ranges on the IP4 Ranges tab. JDisc Discovery only pings enabled 
ranges (indicated by the check mark).

Fig: Define IP4 networks and IP4 address ranges

2.3.9 Windows Network Neighborhood Objects

JDisc Discovery can discover member computers of Windows domains and 
workgroups For each Windows domain or workgroup that is enabled for discovery, 
JDisc Discovery queries computer names of member computers using the Windows 
network neighborhood. JDisc Discovery's discovery uses WINS and DNS to convert 
computer names into IP addresses. 

Click Change to enter Windows domain administrator login credentials. JDisc 
Discovery's uses these login credentials when discovering computers that are member 
of a Windows domain or workgroup.
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To collect detailed information of Windows computers, 
administrative login credentials are required. Without administrative 
login credentials, JDisc Discovery will only collect basic information.

Configuring administrative login credentials for Windows domains 
avoids configuring login credentials for each Windows computer.

Figure: Define Windows Network Neighborhood Objects

2.3.10 Directory Objects

JDisc Discovery supports Microsoft Active Directory for discovery of Windows 
computers that are a member of a directory. Active directory permits to configure  JDisc
Discovery's discovery on a finer level of granularity than Windows domains allow. 
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On the Directory tab expand the directory hierarchy, select one or multiple directory 
objects and enable them for discovery. JDisc Discovery queries member computers of 
enabled directory objects. Use Change to configure administrative login credentials to 
discover member computers of enabled directory and sub-directory objects.

You can configure login credentials on different levels of the directory hierarchy. JDisc 
Discovery attempts to use login credentials from the the deepest directory objects first. 
When a login credential fails, JDisc Discovery then tries to use login credentials from 
higher levels of the directory hierarchy.

Windows computers require administrative login credentials to 
collect detailed device information. Without administrative account 
privileges JDisc Discovery will get only limited device information.

Using login credentials for  directory objects is a convenient way to 
avoid configuring login credentials for each Windows computer.

2.4 Start The Discovery

The Discovery » Control menu allows to start, stop, pause, and resume the discovery 
process. It also contains menu items to manually initiate a directory and network 
synchronization for all configured directories. 

Figure: Start the Discovery

Click Start Discovery to start the first discovery cycle. JDisc Discovery will start pinging 
the local network. 

The status dialog displays the current discovery status: 

● The Devices tab displays devices and IP addresses that are currently 
discovered.

● The Ping tab displays IP4 networks and ranges currently being discovered. In 
this example Product discovers the network 192.168.178.0 with the subnet mask 
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255.255.255.0.

● The Network Neighborhood tab displays Windows network neighborhood 
objects currently being discovered.

● The Directory tab displays directory objects currently being discovered and the 
directory object/network synchronization status. 

● The Discoveries tab displays discovery cycle status information, such as last 
start and finished date.
 

Figure: The Discovery Status

The discovery duration depends on the network size, utilization, access speed and also 
the performance of the computer running JDisc Discovery.

2.5 Review The Result

JDisc Discovery provides a variety of built-in reports that allow viewing different aspects 
of your device inventory. Reports can be run at any time while the discovery is running 
and reflect the current discovery result. 
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Open the All Devices report from the Devices menu to view all discovered devices.

Figure: Open the All IP Devices Report

The All IP Devices report displays a list of all devices and selected attributes such as 
Name, IP address, Manufacturer, Model, Type to name just a few.

Figure: All Devices Report

Reports are linked to other reports. Open the context menu in the report main area to 
open links to other reports. JDisc Discovery maintains a history of visited reports. 
Reports typically have a tool bar with shortcuts to frequently used actions:

Display all available actions for the current selection.

Return to the previous report in the report history.
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Go to the next report in the report history.

Refresh the current report.

Open a new Window with the same report.

Export the current report to a Microsoft Excel sheet using the current sorting 
and filtering options.

Export the current report to a CSV plain text file using the current sorting and 
filtering options.

Display the SQL query that created the current report.

Schedule report export.

Display the group tree to limit the report to specific groups only (refer to section 
3.3 for more details on device grouping).

Adjust the column width to fit its content.

Use the filter field to limit the report to records that contain the filter value. Using filters 
is also a simple way to find data in a report. Select the 'Case sensitive filter' option to 
filter values in the report case sensitive.
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3 Concepts

The Concepts chapter explains JDisc Discovery's discovery concepts and the user 
interface.

3.1 Pattern Matching

Pattern matching can be used to define conditions in custom reports and device groups 
for certain device attributes,such as model, manufacturer, etc.

JDisc Discovery offers two pattern matching algorithms:

● Wildcards

● Regular expressions

3.1.1 Wildcard Matching

Regular expressions are powerful, but sometimes difficult to use. This is why JDisc 
Discovery offers wildcard matching similar to wildcards available in a command shell. 
There are two wildcards:

● '*' matches any number of characters (including 0)

● '?' matches exactly one character

For instance, the expression 'Ci???*' matches the string 'Cisco', 'Cisco Router', but not 
'Switch Cisco'. 

3.1.2 Regular Expression Matching

JDisc Discovery uses Posix regular expressions. Refer to the Internet for a more 
detailed description of Posix regular expressions.

3.2 Discovery

The Discovery section covers the general discovery process in detail, protocols and 
ports, and explains why JDisc Discovery needs login credentials to work properly.
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3.2.1 The Discovery Process

Discovery is the process of finding and identifying devices on a network. The discovery 
process also covers device specific data collection once a device has been identified. 

Finding a device means to detect an IP address of an active device on the network. 
Identifying a device is the process that determines the device type, device model, and 
its manufacturer.

When a device has been identified and depending on the device type, the discovery 
collects additional hardware, software and configuration.

JDisc Discovery defines discovery of a device as the sequence of finding its IP 
address(es), identifying the device, and collecting additional data.

Other software vendors define the term Discovery differently for their products. 
Take this into consideration hen comparing different discovery products.

Although the process of finding, identifying, and collecting data from a device is strictly 
sequential, JDisc Discovery can discover devices concurrently thus speeding up the 
discovery. The number of concurrent device discoveries can be configured in JDisc 
Discovery's discovery settings.

JDisc Discovery offers several options to find new IP addresses. Depending on the 
configuration finding new IP addresses can happen by:

● Pinging IP4 sub-networks

● Pinging IP4 address ranges

● Browsing computers using the Windows network neighborhood

● Querying computes in a directory

● Finding new IP addresses in a device's ARP cache2

● Finding new IP addresses in a device's connection table3

Whenever JDisc Discovery has detected an active IP address it will identify the device. 
Identifying a device implies sending network requests (for instance SNMP, NetBIOS, 
WMI, etc.) to the device to collect identifying information. Protocols can be enabled or 
disabled independently in JDisc Discovery's discovery settings.

When a device has been identified, JDisc Discovery will (depending on the 
configuration) collect hardware, software and configuration data. 

Most devices require access credentials to collect hardware, 
software and configuration data. Without credentials, JDisc 
Discovery collects only basic information.

2 A device's ARP cache maintains a mapping between the IP address and the MAC address of a computer on a 
network.

3 The connection table maintains a list of ports and IP addresses to connected devices.
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3.2.2 Ports And Protocols

Alike other agent-less discovery applications, JDisc Discovery relies on protocols that 
are available on devices. The following table lists all protocols including their port 
numbers.

Protocol Ports

Domain Name System (DNS) 53 (TCP)

Hypertext Transfer Protocol (HTTP) 80 (TCP)

Secure Hypertext Transfer Protocol (HTTPS) 443 (TCP)

Multicast DNS (mDNS) 5353 (UDP)

Universal Plug and Play (UPnP) 1900 (UDP)

Lightweight Directory Access Protocol (LDAP) 389 (TCP)

Lightweight Directory Access Protocol (LDAPS) 636 (TCP)

Lightweight Directory Access Protocol (LDAP)
(Global Catalog)

3268 (TCP)

Lightweight Directory Access Protocol (LDAPS)
(Global Catalog)

3269 (TCP)

Network Basic Input/Output System (NetBIOS) 137 (UDP)
138 (UDP)
139 (TCP)

Packet Internet Grouper (PING) n/a

Secure Shell (SSH) 22 (TCP)

Simple Network Management Protocol (SNMP) 161 (UDP)

Server Message Block (SMB) 445 (TCP)

Telnet 23 (TCP)

VMware API (VIM SDK) for VMware Server 8333 (TCP)

VMware API (VIM SDK) for VMware ESX Server 443 (TCP)

Web Based Enterprise Management (WBEM) 5989 (TCP))

Windows Remote Login Relies on SMB

Windows Remote Registry Relies on SMB

- 34 -



Windows Management Interface (WMI) 135 (TCP) and
a negotiated port 
between 1024 and 
65535 (TCP)

Table: Protocols and Ports

Firewalls (either personal firewalls installed on computers or 
firewalls separating networks) can block discovery traffic. In order 
to get proper discovery results, firewalls must be configured such to 
let network traffic pass the above mentioned port/protocols.
Alternatively, in the case of firewalls separating networks, multiple 
JDisc Discovery installations might be an option to workaround the 
firewall restrictions. 

3.2.3 Login Credentials

Most protocols require some kind of authentication to collect data from devices on the 
network. Without login credentials devices usually refuse connection attempts or do not 
return any data at all. Depending on the protocol and the device platform login 
credentials must have administrative privileges or only ordinary user privileges.

Protocol Credentials

Domain Name System (DNS) None

Hypertext Transfer Protocol (HTTP) None

Secure Hypertext Transfer Protocol (HTTPS) None

Lightweight Directory Access Protocol 
(Global Catalog)

Any non privileged 
directory user account

Network Basic Input/Output System (NetBIOS) None

Packet Internet Grouper (PING) None

Secure Shell (SSH) Non root user on Unix. 
Some information 
requires root user 
privileges on Linux.

Simple Network Management Protocol (SNMP) SNMP read community
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or SNMPv3 account

Server Message Block (SMB) Either none (little 
information with 
anonymous SMB), non 
administrative account, 
or administrative 
account

Telnet Non root user on Unix. 
Some information 
requires root user 
privileges on Linux

VMware API Read-only user for the 
vCenter installation. 
Scanning ESX servers 
directly (not using the 
vCenter) requires root 
access.

Web Based Enterprise Management (WBEM) Administrative / root 
account.

Windows Remote Login Administrative account

Windows Management Interface (WMI) Administrative account

Table: Protocols and access credentials

This is the most important rule: 

No login credentials, no or very superficial information!

3.2.4 Credential Handling

JDisc Discovery stores a successfully tested access credentials for each device. When 
a device gets discovered again, then JDisc Discovery uses the access credentials that 
succeeded the last time. Otherwise, it would have to test all default accounts again 
which can be time consuming.

JDisc Discovery tests the default accounts when the assigned access credentials do 
not work anymore (for instance, because an administrator has changed the password).

In some cases, you might want to clear all assigned access credentials for devices. 
There are two ways to accomplish this task:

1. Clear accounts (e.g. user/admin accounts or SNMP communities) for selected 
devices. Use the context menu Manage » Change... in order to clear selected 
accounts.
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2. Use the context menu Manage » Clear Cached Accounts... in order to delete all 
cached device accounts.

Figure: Clear Cached Access Credentials

3.2.5 Remote Login

Depending on the device platform, operating system and configuration, management 
protocols, such as SNMP, WBEM, or WMI are not available. In such a case, JDisc 
Discovery can use telnet and/or SSH to collect hardware, software and configuration 
information. Once connected, JDisc Discovery executes system commands to collect 
hardware, software and configuration information not available through other 
management protocols. The commands that are executed depend on the device's 
platform and operating system. When JDisc Discovery discovers Linux computers, root 
privileges are requires to read model, serial number and manufacturer information from 
the computer's BIOS. JDisc Discovery can call su, sudo or .do to get root privileges. 
The discovery settings allow choosing su, sudo or .do as preferred method. When sudo 
or .do fail, JDisc Discovery tries su as fallback.

Remote login is enabled by default for Windows and Unix.

Remember: Remote login is enabled by default.
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Be careful when using SSH based remote login in conjunction with 
default accounts. Trying too many default accounts might cause 
security alerts.

Remote login for Windows helps to avoid WMI or remote registry 
access problems by tunneling the two protocols through the remote 
login agent.
In addition to solving access problems, tunneling WMI and remote 
registry can improve the discovery speed of Windows computers 
that are connected to slow or wide area networks.

3.3 Device Grouping

Device grouping is a concept that permits grouping devices by geography, 
organizational structure or other criteria. Group conditions can be created using any of 
the device attributes below: 

● Membership to an IP4 network

● IP address within an IP4 address range

● Membership to a Windows network neighborhood object

● Membership to a directory object

● Device attributes such as model or manufacturer

While the discovery is running, JDisc Discovery assigns devices to group based on the 
group conditions. This eliminates the need to manually assigning devices to groups, 
which would be nearly impossible for large number of devices.

Devices are automatically assigned to groups during the discovery.

When the group hierarchy or group conditions change, devices are only reassigned to 
groups during the next discovery cycle. Alternatively, you might trigger manual 
reassignment of devices to groups by opening a device report (for instance All 
Devices), select the devices to reassign, open the context menu and select Manage » 
Synchronize Group Assignment... 
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Figure: Synchronize Group Assignments

Save time and manually reassign devices after a group 
configuration change.

The root group is always associated with all devices, all networks, all Windows network 
neighborhood objects and all directory objects. The root group's conditions are 
immutable.

3.3.1 Define Your Own Groups

Open Discovery » Settings and select Scope. The device group hierarchy is located 
in the left navigation panel. Groups can be freely organized in a hierarchy. Select a 
parent group, open the context menu using a right mouse click and choose a group 
type.

Figure: Create New Group

JDisc Discovery offers five types of groups:

● Network/range groups assign devices based on IP4 network or IP4 address 
range conditions. When a device's IP address(es) matches any of the IP4 
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networks or IP4 ranges in the group condition the device will be assigned to the 
group.

● Windows network neighborhood groups assign devices based on membership to 
Windows network neighborhood objects. When a device's Windows network 
neighborhood matches any of the Windows network neighborhood objects in the 
group condition the device will be assigned to group.

● Directory groups assign devices based on membership to a directory object or a 
hierarchy of directory objects. When a device's directory object matches any of 
the directory objects in the group condition the device will be assigned to the 
group.

● Cloud Groups assign cloud resources to based on cloud provider account 
configuration. Cloud groups are used extensively for Cloud Discovery jobs and 
allow you to organize, enable, or exclude cloud accounts (e.g., AWS, Azure, 
SOTI) from discovery jobs using the group mechanism.

● Groups assign devices based on device attributes. Groups can be created 
based on the following device attributes:

● Device model

● Device manufacturer

● Device type

● Device name

The Group Info menu item displays a textual description for the group definitions.

3.3.1.1 Create Network/Range Groups

Corporate and enterprise networks are usually divided into sub-networks. Often sub-
networks or a set of sub-networks belong to country, site, building or even floors in a 
building. Therefore network/range groups are useful to create groups that map 
networks to geographical locations.

To create a group, select a parent group, open the context menu and select Create 
new network/range group. Enter a group name and description and click Ok.

Figure: Create new Network/Range Group
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The new group will be added to the group hierarchy. Select the new group in the 
hierarchy to change the group's configuration. Note: The Network Neighborhood and 
Directory tabs disappears when selecting the network group.

Figure: Define Networks associated with this Group

The new group is not yet associated to an IP network or IP range. To associate the 
group with an IP network

● Click Add to add a new network

● Click Browse to browse and select existing networks

● Click Import to import a list of networks from a comma separated file (CSV). The 
file format is a string containing the network base address and subnet mask 
separated by a comma and a carriage return.

Enable the networks that should be discovered. JDisc Discovery will assign devices to 
the group regardless whether the networks in the group's condition are enabled or 
disabled.

The name field in the network table is editable. You may enter a name for the network 
for documentation purposes.

Figure: A Network Group with one Network
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The group 'Berlin' is associated with network ('192.168.178.0 / 255.255.255.0'). Devices 
this network will be assigned automatically to this group during the next discovery 
cycle.

Specifying IP address ranges works the same way.

The name field in the network and IP address range table is editable. Use this 
field to provide meaningful names for IP networks and ranges.

3.3.1.2 Create Windows Network Neighborhood Groups

Using Windows network neighborhood groups is beneficial when Windows domains 
reflect the organizational structure such as a single domain per organization. 

Select a parent group, open the context menu and select Create new Windows network 
neighborhood group. Enter a group description in the new group dialog and click Ok.

Figure: Create new Network Neighborhood Group

The new Windows network neighborhood group will be added to the group hierarchy. 
Select the new group in the hierarchy to change the group's configuration. Note: All 
other tabs disappear but only the Network Neighborhood tab is visible. 
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Figure: The Network Neighborhood Group

The new Windows network neighborhood group is not yet associated with any 
Windows network neighborhood object. To associate the new group with a Windows 
network neighborhood object

● Click Add to add a new Windows network neighborhood object that might not yet 
exist in JDisc Discovery's database.

● Click Browse to browse and select existing Windows network neighborhood 
objects.

● Click Import to import Windows network neighborhood objects from a comma 
separated (CSV) file.

● Click Change to enter login credentials for selected network neighborhood 
objects.

Figure: Group with Associated Windows Neighborhood Objects

Enable the Windows network neighborhood objects for discovery. JDisc Discovery will 
assign devices to this group regardless whether the Windows network neighborhood 
objects in the group's condition are enabled or disabled.

It is recommended to enter administrative login credentials for Windows domains. This 
enables JDisc Discovery to collect detailed hardware, software and configuration 
information from Windows computers that belong to Windows domains.

Enter administrative login credentials for Windows domains to 
improve the discovery result.

3.3.1.3 Create Directory Group

Using directory groups is helpful for creating groups that map the organizational 
or geographical structure of a corporation or an enterprise.
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Select a parent group, open the context menu and select Create new directory 
group. Enter a group description and click Ok.

Figure: Create new Directory Group

The new directory group will be added to the group hierarchy. Select the new group in 
the hierarchy to change the group's configuration. Note: All other tabs disappear but 
only the Directory tab is visible. 

Expand the directory hierarchy, select directory objects and click Toggle to include or 
exclude selected directory objects in the group's configuration.

Click Change Account to enter administrative login credentials for the selected directory 
objects. JDisc Discovery will use the login credentials to discover member computers of 
the selected directory objects or any subordinate directory objects. The login 
credentials enable JDisc Discovery to collect detailed hardware, software and 
configuration information from Windows computers that belong to a directory.

Figure: Directory Group with associated Directory Objects

Enter administrative login credentials for directory objects to 
improve the discovery result.
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3.3.1.4 Create A Group Based On Device Attributes

Select a parent group, open the context menu and select Create new group. 
Enter a group description and click Ok.

Figure: Create a new Group

The new group will be added to the group hierarchy. Select the new group in the 
group tree to change its configuration. Select the Specification tab to define the 
group membership rules.

Fig: Group Specification

Initially the group specification is empty and thus no devices will be assigned to 
the group. Click Change to add group conditions or modify the group 
specification. On the Group Specification dialog select attributes from the 
navigation tree and build conditions .

Group conditions can use any of the attributes below:
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● Device name

● Device model

● Device manufacturer

● Device type

● Operating system family

● Operating system version

● Operating system patch level

Figure: Change Group Specification

Select an attribute and add a new condition by selecting the operator (in this 
case '=') and a value (in this case 'Dell'). Click Add to add the condition to the 
group specification.

Depending on the attribute type, JDisc Discovery offers the following operators:

● equals

● not equals

● contains

● contains (case insensitive)

● greater than

● greater than or equal
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● less than

● less than or equal

● between

● matches regular expression

● matches wildcard expression

Refer to chapter 3.1 for more information about pattern matching.

The Specification tab shows a summary of the group definition.

Figure: Group definition summary

3.3.1.5 Groups And Default Accounts

Corporate and enterprise networks typically run large numbers of SNMP enabled 
devices and Unix computers. Often times, SNMP enabled devices and UNIX computers 
share the same local access and login credentials but are not member of a Windows 
domain or a directory (for technical or organizational reasons) that could simplify the 
credentials configuration.
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This is why JDisc Discovery's default access and login credentials feature to reduce the 
configuration effort or SNMP enabled devices and UNIX computers. JDisc Discovery 
attempts to authenticate configured default SNMP communities and UNIX login 
credentials up until one of them succeeds, associates and stores the credentials with 
the device in the database. The group hierarchy and order of default credentials within 
a group determine the order of default credentials JDisc Discovery's attempts to 
authenticate. Default credentials in subordinate groups are tried first and only if these 
fail, JDisc Discovery attempts to authenticate default credentials of superordinate 
groups up until it reaches the root group. JDisc Discovery's installation program adds 
the 'public' default SNMP community to the root group. 

JDisc Discovery attempts to authenticate credentials in subordinate 
groups first. If credentials of subordinate groups fail, JDisc 
Discovery will attempt to authenticate credentials of superordinate 
group until the root group is reached or authentication succeeds.

Having only one global list of default credentials might cause problems in corporate and 
enterprise networks because JDisc Discovery will attempt to authenticate all default 
credentials in the worst case (if all fail) and might trigger security alerts (especially, 
when using SSH) and intrusion detection systems. Because of that it is important to 
keep the number of default credentials to a minimum. JDisc Discovery allows 
configuring default SNMP communities and login credentials for each group. Group 
based default credentials offer better granularity than a global definition of default 
credentials and thus reduce the risk of security alerts.

Keep default credentials to a minimum to avoid triggering security 
alerts (especially when using SSH) and intrusion detection 
systems.
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Open the Discovery Settings dialog, select a network group and click select the SNMP 
tab.

To add default SNMP communities to a group, click Add. Remove will delete selected 
default SNMP communities. Click Move Up and Move Down to change the order of 
selected default SNMP communities. 

Use the buttons in the SNMPv3 Accounts panel to create, delete or reorder default 
SNMPv3 accounts.

Figure: Default SNMP Communities and SNMPv3 Accounts

Select the Accounts tab to create default accounts for UNIX platforms. You can help 
JDisc Discovery's discovery by specifying the account type (root or non-root account). 

Choose default SSH public/private keys after importing keys into the JDisc Discovery 
application. Refer to section 5.9 on how to import SSH keys.

3.3.1.6 Create Cloud Groups

Cloud groups allow you to manage cloud provider accounts (e.g., AWS, Azure, SOTI) 
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as part of the JDisc Discovery's scope. Cloud groups are essential when seperating 
discovery jobs per cloud provider or cloud account.

To create a cloud group:

1. Select a parent group under the Scope tab.

2. Open the context menu and choose Create a new Cloud Group.

3. Enter  a group name  and description and click OK.

Figure: Create new cloud group

Once the cloud group is created, select it in the group hierarchy to configure it.

You can:

• Add or remove cloud accounts.

• Enable or disable accounts to control whether they are scanned during 
discovery.

• Delete the group if it is no longer needed.
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Figure: Configure cloud group accounts

During a discovery job:

• If a cloud account is enabled in the Scope tab and also the cloud group involving 
it is selected for the discovery job, its enabled accounts will be scanned.

• Accounts not enabled will not be scanned by the discovery job.

This provides precise control over which cloud resources are disccovered in each job.

Figure: Enable the cloud group for the discovery job.
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Figure: Manage default Accounts for UNIX Platforms

3.3.2 Groups And Reports

Groups can do more than structuring devices by organizational or geographical criteria 
and simplifying the discovery configuration. You can use groups to restrict JDisc 
Discovery's reports and graphical views to devices that are member of a group or a 
hierarchy of groups. 

In a report or graphical view click the grouping icon  to open the group tree. The 
group icon might be disabled in reports where grouping is not applicable.
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Figure: Report with Grouping Hierarchy

Select groups in the group hierarchy to display devices that are associated to the 
selected groups.

3.4 Scheduled Discovery Jobs

JDisc Discovery can schedule discovery jobs to start automatically. A discovery job is 
comprised of a set of groups define the discovery scope. In its simplest form a 
discovery job can be comprised of just the root group. To accommodate the discovery 
of more complex networks that might span across different continents and timezones, a 
discovery job can be comprised of a set of groups with each group defining different 
discovery scopes. 

Discovery jobs can be scheduled using one of these schedule types:

● Not scheduled: Discovery job must be started manually

● Run once: Run once at a particular date and time

● Run daily: Run daily at a particular time

● Run weekly: Run weekly at a particular day and time

● Run monthly: Run monthly at a particular day of the month and time

● Recurring: Run recurring within a configurable interval

In it's default configuration, JDisc Discovery comes with a built-in discovery job called 
'Discover all', which includes all networks, IP4 address ranges, Windows network 
neighborhood objects and directory objects that are enabled for discovery including all 
subgroups. 
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Figure: The 'Discover all' Discovery Job

The concept of discovery jobs is powerful and flexible. While it is easy and simple to 
use for small company networks, discovery jobs also fits corporate and enterprise 
networks with locations and sites spread across the world.

For example: A corporation would like to run JDisc Discovery to create a world wide 
inventory. The discovery server running JDisc Discovery is located in a data center in 
Europe. JDisc Discovery can only discover devices that are powered on and connected 
to the network. Consequently, devices that are turned off or are disconnected from the 
network cannot be discovered, such as the ever increasing number notebooks and 
PDAs. Because of that, it is essential to discover mobile devices during office hours. 
The JDisc Discovery administrator has already created groups for countries and sites. 
Now the administrator would like to schedule a discovery job for the Atlanta site. The 
time leap between the discovery server and the Atlanta site is 7 hours. Therefore (to 
discover devices during office hours in Atlanta) the discovery should start at 3pm 
(discovery server local time).

To create a new discovery job, open the context menu in the Discovery Jobs panel and 
choose Add new discovery job. Enter a meaningful discovery job name and description 
in the New Discovery dialog and click Ok.
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Figure: Create a new Discovery Job

Select the new discovery job from the Discovery Jobs panel:

● Enter a meaningful name and description in the Properties tab.

● Select groups to associate with the discovery job in the Groups tab.

● Select the Directory tab to configure directory synchronization options. JDisc 
Discovery can synchronize directory hierarchies and networks from directories 
when a discovery job starts.

● Select the Schedule tab to schedule the discovery job.

Choose one of the options below:

● Not scheduled: Discoveries are not scheduled. Start a discovery manually from 
Discovery » Control » Start Discovery.

● Run once: Run the discovery job once at a particular time and date.

● Run daily: Run the discovery job daily at a particular time.

● Run weekly: Run the discovery job weekly at a particular day and time.

● Run monthly: Run the discovery job monthly at a particular day of the 
month and time.

● Recurring: Run the discovery job regularly.

Define blackout periods for recurring or daily schedules. A blackout period 
defines when not to run a discovery. Define blackout periods based on

● one or more daily intervals

● one or more days of the week

● one or more days of the month
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3.5 Control The Discovery

JDisc Discovery's discovery can be controlled from the Discovery » Control menu or by 
clicking the icons from the tool bar. The discovery process can be either running, idle, 
paused, or disabled.

Figure: Control Discovery Menu

3.5.1 Start Discovery

Choose Start Discovery or click the start icon  to start a discovery job. The discovery 
job starts immediately when only one discovery job is configured. JDisc Discovery' 
displays the Start Discovery dialog if more than one discovery job is configured. From 
the Start Discovery dialog select the discovery job that you want to start.
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Figure: Select and start a Discovery Job

3.5.2 Stop Discovery

Choose Stop Discovery or click the stop discovery icon  to stop a discovery job. 
JDisc Discovery prompts which discovery job to stop if more than one discovery job is 
running. Otherwise, if only one discovery job is running the discovery stops 
immediately.

3.5.3 Pause Discovery

Choose Pause Discovery or click the pause icon  to pause all running discovery jobs. 

Discovery jobs cannot be paused individually. JDisc Discovery can 
only pause all running discovery jobs at once!

3.5.4 Resume Discovery

Choose Resume Discovery or click the start discovery icon  to resume paused 
discovery jobs.
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3.5.5 Synchronize Directory

Choose Synchronize Directory to synchronize directory information in JDisc Discovery's 
database with configured directories. 

Synchronizing directory information requires configuration of a DNS 
Domain Controller and login credentials. Refer to section 5.3.1 for 
how to configure directory DNS Domain Controllers.

3.5.6 Synchronize Networks

Choose Synchronize Networks to synchronize IP4 networks in JDisc Discovery's 
database with IP4 networks from configured directories. Refer to section 5.3.1 for how 
to configure directory DNS Domain Controllers.

Synchronizing IP4 networks from a directory requires configuration 
of a DNS Domain Controller and login credentials. Refer to section 
5.3.1 for how to configure directory DNS Domain Controllers.

3.6 The Status Panels

JDisc Discovery's main window displays status information.

The status panel is divided into these sub-tabs:

● The Devices tab displays statistics about devices and IP addresses already 
discovered, pending IP addresses and displays devices that are currently 
discovered.

● The Ping tab displays what IP4 networks and IP4 ranges are currently pinged 
and the total number of IP addresses processed and pending for discovery.

● The Windows Network Neighborhood tab displays the Windows network 
neighborhood discovery current activity and the total number of Windows 
network neighborhood objects processed and pending for discovery.

● The Directory tab is divided into two panels. 

○ The Synchronization panel displays directory and network 
synchronization status. 

○ The Queue panel displays displays the directory discovery current activity 
and the total number of directory objects processed and pending for 
discovery.

● The Topology Jobs tab appears only when the 'Networking Add-On' is installed 
on top of JDisc Discovery. This tab lists all running network topology discovery 
jobs.
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● The Device History tab appears only when the 'History Add-On' is installed on 
top of JDisc Discovery. This tab lists all currently running device history tasks.

● The Data Quality tab displays statistics about the discovered data quality. Tips 
on how to improve the data quality help to get the most out of JDisc Discovery.

● The Discovery Jobs tab lists all scheduled discovery jobs with their status.

● The Database tab shows statistics about the database size and the number of 
entries within the tables. 

Figure: The Main Window with Status Information

Icons in the Status area display the discovery's current state

The discovery is idle.

The discovery is running.

The discovery is paused.

JDisc Discovery is stopped. Only administrative tasks such as archiving and 
restoring the database can be executed while JDisc Discovery is stopped.
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3.6.1 Devices Status

The Devices status tab displays aggregated devices statistics spanning across all 
running discovery jobs. In addition to that the table view displays progress for each 
devices currently discovered.

● Concurrent device discoveries displays the number of devices currently 
discovered concurrently. The maximum number of concurrent device discoveries 
can be configured in JDisc Discovery's discovery settings.

● Average duration displays the average device discovery duration based on the 
average discovery duration of the last 200 devices and also an estimated device 
discovery rate forecast.

● Discovery jobs displays the total number of IP addresses pending for discovery 
from manually or automatically scheduled discovery jobs.

● Manually triggered displays the number of IP addresses that have been 
manually triggered for discovery.

● Devices in database displays the total number of devices in JDisc Discovery's 
database.

The table view displays device IP address, current discovery duration and discoveries 
activity for each device.

Figure: The Device Status Tab 

The Discovery job and Manually triggered counters refer to IP 
addresses only. Device can have multiple IP addresses assigned 
and. therefore the number of IP addresses discovered might 
become higher than the number of devices in the database.

3.6.2 Ping

The Ping tab displays progress when pinging IP4 sub-networks and address ranges. 
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Status displays current activity. The upper table view displays overall ping progress 
separately for scheduled and manually triggered discovery jobs.

● The number of IP networks to ping

● The number of IP address ranges to ping

● The total number of IP addresses pending to ping

Figure: Ping Status during Discovery of a Network

The lower table view displays processing of IP networks and ranges. A progress bar 
indicates the progress when pinging an IP network or range.

JDisc Discovery can ping up to 10 IP networks or ranges 
concurrently.

3.6.3 Windows Network Neighborhood Status

The Windows Network Neighborhood tab displays Windows network neighborhood 
discovery progress.

● Status displays current activity.

● Current object displays the Windows network neighborhood object being 
processed. 

● Pending objects displays the total number of Windows network neighborhood 
objects pending for discovery. 

● Processed objects displays the total number of Windows network neighborhood 
objects discovered.
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Figure: The Windows Network Neighborhood Status

3.6.4 Directory Status

The Directory tab displays directory discovery and directory synchronization status. 

The Synchronization panel displays aggregated directory object and network 
synchronization statistics.

● Added displays the total number of directory objects and networks added to the 
database. 

● Removed displays the total number of directory objects and networks removed 
from the database. 

● Synchronized displays the total number of directory objects and networks 
synchronized with the database. 

● Status displays current activity of the directory object and network 
synchronization.

The Queue panel displays directory objects discovery status.

● Status indicates the directory discovery's operational state, such as Running, 
Idle or Paused.

● Message displays current activity.

● Processed displays the total number of directory objects discovered. 

● Pending displays the total number of directory objects to be discovered. 
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Figure: Directory Status

3.6.5 Status Of Discovery Jobs

The Discovery Jobs tab displays the status of discovery jobs. The table view displays: 

● Discovery Job displays the discovery job name.

● Status displays the current status.

● Last Started displays when the discovery was last started. This column is empty 
when the discovery job was never been started.

● Last Finished displays when the discovery job finished. This column is empty 
when the discovery job never completed.

● Duration displays the discovery job duration. This column is empty when the 
discovery job never completed.

● Next Schedule displays the date and time for the next scheduled discovery. This 
column is empty when the discovery job was not scheduled.

Figure: Discovery Jobs Status
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3.6.6 Data Quality

The Data Quality tab displays data quality information on how well devices have been 
discovered.

Figure: Data Quality tab

The 'Total' panel displays the data quality of all devices and operating systems  whereas 
the 'By Operating System Family' panel displays the data quality of each operating system 
family individually. Click the How to improve link next to the quality meter to display 
diagnostic information on how to further improve the data quality.

3.6.7 Database Status

The Database panel displays the database size on the disk, the number of rows in 
each table and the size of the table on the disk (including required space for indexes)

Figure: Database status

- 64 -



- 65 -



4 Discovery Scenarios

This chapter describes common discovery scenarios and explains how to configure 
JDisc Discovery to best discover Windows and Unix computers. Furthermore, it also 
provides guidance on how to improve the discovery of other networked devices such as 
printers, switches, and routers.

4.1 Active Directory Environments

JDisc Discovery supports Active Directory environments in many ways, such as

● Automatically detect directories and DNS domain controllers on the network. 

● Synchronize directory objects and IP networks with JDisc Discovery's database.

● Automatically assign member computers to directory objects. 

● Discover member computers of directories that are associated with DNS 
domains, organizational units or containers.

● Simplify the configuration of access credentials for directory member computers. 

4.1.1 Directories And DNS Domain Controllers

JDisc Discovery uses the SMB (Server Message Block) protocol to detect directories, 
Global Catalog (GC) servers DNS domain controllers (DC) on the network. Often times 
(depending on the security settings of target computers) this does not require entering 
credentials. The automatic detection of directories, Global Catalog (GC) servers and 
DNS domain controllers (DC) simplifies the configuration of Active Directory 
environments and also reveals unknown directories on the network.

You can view directories from Networking » Directories. Directories that have not yet 
been synchronized only have DNS domain objects. Organizational units and containers 
will be added underneath DNS domain objects when a directory is synchronized.

4.1.2 Manually Discover DNS Domain Controllers

You can configure Gloabal Catalog (GC) servers and/or DNS domain controllers (DC) 
of a directory before running your first discovery job. When you do not know your 
Global Catalog  (GC) servers or DNS domain controller (DC) host names, follow the 
instructions below:

● Make sure the 'Discover DNS domain controllers' option is checked on the 
General tab of the Discovery Configuration dialog.
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● From the Discovery » Discover Device menu open the Discover Device dialog 
and enter the directory's DNS domain name.

● Wait until the discovery returns to idle state.

● Open the Discovery Configuration dialog from Discovery » Configuration and 
choose the Directory tab.

● If JDisc Discovery has discovered at least one DNS Domain Controller of the 
specified DNS domain name:

● The DNS domain name is displayed in the DNS Domains panel 

● And the DNS Domain Controller is displayed in the DNS Domain Controller 
panel.

● See section 5.3.1 for how to configure login credentials for DNS Domain 
Controllers.

4.1.3 Synchronization Of Directory Objects And IP Networks

When JDisc Discovery has detected a directory and at least one Global Catalog (GC) 
server or DNS domain controller (DC), you can enter login credentials (non-privileged) 
to access the DNS domain controller (DC) or Global Catalog (GC) servers (see section 
5.3.1 for details). 

JDisc Discovery uses these login credentials to run LDAP queries on the Global 
Catalog (GC) and DNS domain controllers (DC). Typically DNS domain  controllers 
(DC) also run the Global Catalog (GC) service. This is why DNS domain controllers 
(DC) and Global Catalog (GC) servers are often user interchangeable. 

When JDisc Discovery synchronizes directory objects and IP networks, it runs a series 
of LDAP queries against the Global Catalog (DC) service. 

To synchronize directories, choose Settings » Sync Directory. 

Synchronizing a directory requires at least one DNS domain 
controller and login credentials to run LDAP queries. 

4.1.4 Relating Member Computers To Directory Objects

JDisc Discovery determines the directory membership of discovered computers / 
devices by using their:

• fully qualified host names (FQDNs)

• computer name including the NetBIOS domain name  

• domain security identifier (SID)

When successful, JDisc Discovery relates directory member computers with their 
respective directory objects (DNS domain | organizational unit | container). JDisc 
Discovery uses the administrative logon credentials that are configured for the directory 
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object and sub-objects to log-on to directory member computers and collect hardware, 
software and configuration information. Relating member computers to directory 
objects is important to make directory groups work (see section 3.3.1.3 for details). 
Section 6.3.1 shows a device associated to a directory.

4.1.5 Discover Directory Member Computers

Alike IP networks, IP ranges and network neighborhoods/domains, directory objects 
can be enabled for discovery in many ways. The table below explains the different 
discovery modes that are applicable to directory objects.

Discover all computers of the selected directory object.4

Discover all computers of the selected directory object and all sub-directory 
objects.

Discover recently logged-on computers of the selected directory object.5

Discover recently logged-on computers of the selected directory object and all 
sub-directories.

Figure: Directory Object Discovery Modes

When the discovery is running, JDisc Discovery queries the configured Active Directory 
Global Catalog (GC) service or DNS domain controllers (DC) for member computers of 
enabled directory objects. See also  section 5.2.1.6 for how to enable directory objects 
for discovery and section 6.1.1.1 for how to report member computers.

4.1.6 Simplifying Configuration Of Credentials

Login credentials can be configured for each directory object in a directory hierarchy. 
This enables using different login credentials for discovery of member computers, 
which is very important to accommodate to corporate and enterprise networks, which 
typically do not have single administrator credential for the entire directory. 

JDisc Discovery uses configured login credentials to discover member computers of the 
enabled directory objects or subordinate directory objects. JDisc Discovery uses login 
credentials from the the deepest directory objects first. When a login credential fails, 
JDisc Discovery then tries to use login credentials from higher levels of the directory 
hierarchy. See section 5.2.1.6 for how to configure login credentials for directory 
objects. 

4 This requires only access to one Global Catalog (GC) server/service. 
5 This requires preferably access to all DNS Domain Controllers (DC) of the respective DNS domain.
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4.2 Discover Windows Computers

Windows computers are very common target devices for discoveries. JDisc Discovery 
discovers Windows computers using protocols and technologies, such as SMB, 
NetBIOS, Remote registry, WMI (Windows Management Instrumentation), remote login, 
SNMP or vendor specific agents.

Protocols including SMB, NetBIOS and SNMP (without vendor specific agent 
extensions6) return only limited, but important information, such as operating system 
version.

Other protocols and technologies, such as WMI and remote login collect detailed 
hardware, software and configuration information such as hardware serial number, 
model, manufacturer, or installed applications.

Starting with Windows 2000, Microsoft has included WMI in the Windows operating 
systems. Although a WMI implementation for Windows NT 4.0 exists, it is not installed 
by default. WMI is using DCOM (Distributed Component Object Model) technology 
(which is based on DCE/RPC) for WMI client to server communication. Using WMI 
requires administrative credentials.

JDisc Discovery discovers most hardware information using WMI. 
WMI requires administrative credentials to collect hardware, 
software and configuration information.

Therefore:

No administrative WMI credentials, no detailed hardware 
information from Windows computers!

Enable remote login for Windows in cases where a firewall blocks 
WMI and remote registry traffic. JDisc Discovery tunnels WMI and 
remote registry access through its remote login agent.

JDisc Discovery allows configuring administrative credentials for 

● Directory objects including DNS domains, organizational units or containers

● Windows domains

● Individual computers 

4.2.1 Enter Credentials For Directory Objects

When you run Microsoft Active Directory on your corporate network, you can configure 

6 Most manufacturers (including Hewlett-Packard, Dell and IBM) enhance SNMP agents with proprietary vendor 
specific agents providing detailed hardware information. The standard Windows SNMP agent does not expose 
detailed hardware and software information.
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administrative credentials for Directory objects that can contain computers, such as 
DNS domains, organizational units and containers.

Figure: Change Directory Object Credentials

JDisc Discovery logs on to computers that are member of a directory using credentials 
configured for directory objects. When JDisc Discovery logs on to a computer, it will use 
credentials from directory objects on the lowest applicable hierarchy level first. If no 
access credentials are configured or if access credentials fail, JDisc Discovery will 
begin using access credentials from superior directory objects. 

Directory objects allow configuring credentials more granular than Windows domains 
permit. Refer to section 5.2.1.6 for detailed instructions on how to configure credentials 
for directory objects.

4.2.2 Enter Credentials For Windows Network Neighborhood Objects

Even though Active Directory is around since the year 2000, corporate networks still 
run LAN Manager Windows domains. LAN Manager Windows domains have a flat 
structure in contrast to Active Directory's object hierarchy. 

Enter administrative credentials for a Windows network neighborhood object to 
discover member computers.
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Figure: Configure Windows Network Neighborhood Object Credentials

Configuring administrative credentials for Windows domains eliminates the need to 
configure administrative credentials for each computer. All Windows domain member 
will be discovered using the administrative credentials configured for the respective 
Windows network neighborhood object.

Refer to section 5.2.1.5 for how to configure administrative credentials for Windows 
network neighborhood objects.

4.2.3 Enter Windows Default Accounts

When JDisc Discovery tries to get access to a Windows computer, it must use an 
administrative account. Otherwise, it only gets limited information. The last two 
chapters explained how to configure administrative accounts for the network 
neighborhood (Windows Domain) or for organizational units within Microsoft's Active 
Directory.

However, there are situations, where JDisc Discovery can't determine the network 
neighborhood name or the OU within the directory. For instance, when firewalls block 
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the required protocols or when the device does not register within the directory.

For those cases (and only for those cases), JDisc Discovery provides the possibility to 
add a list of Windows default accounts.

Figure: Default Windows Accounts

Use the list of Windows default accounts only if the configuration 
via network neighborhood or organizational units from the 
directory do not succeed. 

4.2.4 Enter Per Device Credentials

Standalone computers that are not member of a directory or a Windows domain require 
configuration of individual administrative credentials.

 

Per device administrative credentials is the only solution for 
directory and Windows domain member computers that do not 
trust the directory's or Windows domains global Administrators 
group because it has been removed from the computer's local 
Administrators group. 

Open the context menu in any device report and choose Manage » Change Accounts 
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to configure credentials of selected devices.

Figure: Change Device Credentials

Refer to section 6.2.2 for how to configure credentials for individual devices.

4.3 Discover Unix And Apple MAC OS X Computers

JDisc Discovery supports these Unix and Unix based operating systems:

● HP-UX

● Sun Solaris

● Linux (all major distributions)

● VMware ESX server

● Citrix XenServer

● Oracle VM Server

● IBM AIX

● Apple Mac OS X

All of the above Unix flavors typically do not have standard management protocols, 
such as SNMP or WBEM installed out-of-the-box or if installed, often do not provide 
detailed hardware, software and configuration information. 
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JDisc Discovery can overcome the lack of standard management protocols by logging 
on using telnet, executing selected system commands, and parsing the command 
output to retrieve hardware, software and configuration information. Ordinary user 
privileges are sufficient in most cases except of Linux and VMware ESX server), which 
require root access to collect hardware information from the BIOS.

To properly discover Unix computers:

● Enable the remote login for desired operating system platforms. Remote login is 
disabled for all operating system platforms by default. To enable remote login, 
open the Configuration dialog from the Discovery menu. Refer to section 5.6 for 
more details.

● Enable remote login for unknown devices. This option is important for hardened 
systems. JDisc Discovery then first logs on the computer, performs a uname 
command to determine the device platform. If the uname command has 
succeeded, the device is being discovered according to the device platform's 
configuration.

● Configure default credentials for desired operating system platforms. If using 
default credentials is not an option, configure per-device credentials. Refer to 
section 5.2.1.8 for more details on how to configure default credentials.

When discovering a computer, JDisc Discovery logs all commands that have been 
executed in the discovery log.

JDisc Discovery can use telnet or SSH to discover Unix computers 
correctly.

Remote login is disabled by default.

Enter default credentials in the discovery configuration or configure 
per-device credentials.

Root privileges are not required except for Linux and VMware ESX 
server.

4.4 Discover SNMP Based Devices

SNMP is the most common and important protocol to discover networked devices, such 
as routers, switches, or network printers. Network devices typically support SNMP as 
their primary protocol. Unlike computers, network devices often provide detailed 
hardware, software and configuration information in their private SNMP MIB 
(Management Information Base) area.

As most protocols, SNMP requires access credentials. SNMPv1 and SNMPv2c use so 
called 'community' as access credentials. Most manufacturers configure 'public' as their 
factory default community. Therefore JDisc Discovery uses 'public' as default 
community. You can add more default communities when needed. SNMPv3 is the 
security enabled version of the SNMP protocol. SNMPv3 does no longer use 
communities but comes with an user model that offers user authentication and 
password encryption.
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Figure: Change SNMP Access Credentials

Refer to section 5.2.1.7 for how to add new default SNMP communities and accounts.

If using default SNMP communities or accounts is not an option, configure SNMP 
access credentials for each device individually.

4.5 Virtualization Technologies

JDisc Discovery supports these virtualization technologies:

● VMware ESX server (including ESXi) and VMware server running on Linux and 
Windows

● Oracle VM Server

● Xen

● Sun Solaris Zones

● Sun Solaris LDoms

● HP Integrity virtual machines

● Microsoft Hyper-V 

● Sun VirtualBox

JDisc Discovery discovers all active virtual computer instances on a host server and 
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creates relations between the host server and the virtual computer instances it runs. 
Inactive virtual computer instances are ignored.

To return optimal results:

● VMware Tools should be installed on each VMware virtual machine. Without 
VMware Tools being installed, JDisc Discovery cannot discover important virtual 
machine attributes, such as IP address.

● Login credentials are required for each Hyper-V server to discover Hyper-V 
instances. 

VMware Tools improves the discovery result. If VMware Tools is 
absent on VMware virtual machines, JDisc Discovery cannot 
discover the virtual machine's IP address.

The Medium Business or Enterprise Edition is required to discover 
virtual computers and the relationship to host computers except of 
Microsoft Hyper-V discovery which is part of the Small Business 
Edition. 

4.5.1 Scanning VMware Environments

JDisc Discovery scans VMware environments and creates a list of VMware clusters, 
the physical servers, virtual machines and managing vSphere installations.

Without any access credentials, JDisc Discovery uses the HTTP or HTTPS protocol in 
order to identify VMware server installations. In that case, we can at least identify the 
operating system version even though we don't get detailed hardware and software 
information.

Once you provide access to the ESX(i) servers, JDisc Discovery uses the VMware API 
to retrieve the hardware, software and virtual machine information. Using the VMware 
API, JDisc Discovery can get hardware and operating system information for the ESX 
servers and basic information (such as IP address, mac address and configured 
operating system) for the virtual machines.

JDisc Discovery requires direct access to virtual machines in order 
to get detailed hardware and software information. The VMware 
API does not expose detailed information about the virtual 
machine's software configuration.
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Figure: VMware Default Accounts

JDisc Discovery makes use of information that is stored within the vCenter installation. 
The discovery process reads cluster, physcial server and virtual machine information 
out of the vCenter installation. Direct access to the ESX servers is no longer required. 
Vmware's vCenter is often installed on Windows computers. Simply enter the vCenter 
access  credentials  into  JDisc  Discovery's  default  accounts  in  order  to  let  JDisc
Discovery gather information from the vCenter installation.

JDisc  Discovery can  read  information  about  clustering,  physical 
hosts and their virtual machines from the vSphere installation. Root 
access to the physical ESX servers is not required!

4.5.2 Scanning Nutanix

Nutanix is a leading platform for hyperconverged infrastructure (HCI), designed to 
simplify data center operations through software-defined architecture. It integrates 
compute, storage, and virtualization resources into a single, scalable system, 
eliminating the complexity of traditional multi-tier infrastructure.

At the core of Nutanix is the concept of clusters. A Nutanix cluster consists of multiple 
physical hosts - commonly referred to as nodes -that are tightly integrated to form a 
unified pool of resources. Each host runs a hypervisor and also includes a specialized 
virtual machine known as the Controller VM (CVM). The CVM is responsible for 
managing the local resources of its host and for participating in the distributed system 
that spans the entire cluster. Together, these CVMs handle storage services, data 
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replication, high availability, and resource optimization across the cluster, making the 
infrastructure resilient and highly efficient.

To simplify management across multiple clusters, Nutanix offers Prism Central. This 
centralized management solution enables IT administrators to monitor, configure, and 
orchestrate all Nutanix clusters from a single user interface. Prism Central aggregates 
data from various clusters, providing insights into performance, capacity planning, and 
automation tasks. It serves as the control plane for managing virtual machines, storage, 
and applications at scale, and it plays a key role in enabling advanced features like 
analytics, reporting, and policy-based governance.

4.5.2.1 Creating A Nutanix Inventory

Scanning Nutanix environments with IP Scanner Product Inventory is based on 
integrating with the Prism Central APIs. These APIs provide an overview of the Nutanix 
infrastructure by exposing information about:

• The clusters managed by the Prism Central instance

• The physical hosts assigned to those clusters

• The virtual machines running on those physical hosts

However, unlike the VMware APIs, the Nutanix Prism Central API has limitations when 
it comes to detailed hardware-level information. It does not expose low-level hardware 
attributes such as the physical host’s serial number or other BIOS-level details.

To retrieve a complete and accurate inventory of a Nutanix environment, it is necessary 
to combine multiple data sources:

• API access to the Prism Central instance to retrieve high-level information about 
clusters, hosts, and Vms

• SSH access to the physical hosts to query hardware-specific data directly from 
the host operating system

• SSH access to the CVMs to extract cluster-level and host-specific information 
using Nutanix console commands

Only when all three data sources are accessible – Prism Central API, physical host 
SSH, and CVM SSH – can a full and detailed inventory be generated. If any of these 
access methods are missing, the inventory will be incomplete and certain hardware or 
configuration details may not be available.

This architectural limitation is inherent  to the Nutanix API design and must be 
considered when planning the discovery of Nutanix infrastructure.

4.5.2.2 Configuring Nutanix Inventory

To ensure a comprehensive inventory of Nutanix environments in JDisc Discovery, 
several configuration steps must be completed to provide the necessary access 
credentials for all relevant components.

Start by entering the credentials for the physical hosts. These credentials are required 
to connect via SSH and collect detailed hardware information that is not available 
through the Nutanix APIs. You must provide:
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SSH login credentials (username and password or SSH key)

Either the sudo password for privilege escalation or direct root access

This step is essential to gather low-level data such as hardware serial numbers, BIOS 
versions, and other platform-specific attributes.

Next, configure access to the Nutanix Prism Central installation:

● Open the discovery settings in JDisc Discovery

● Navigate to the Virtualization Manager tab

● Add a new entry for the Nutanix Prism Central server by providing the following:

○ A descriptive name for identification

○ The target address (hostname or IP address)

○ Port number used for API communication (typically 9440)

○ API access credentials (username and password)

After saving the configuration, you can initiate a scan. When the IP address of the 
Prism Central server is scanned, JDisc Discovery queries the Prism Central API and 
retrieves available information about:

● All clusters managed by the Prism Central instance

● Physical hosts assigned to those clusters

● Virtual machines running on the hosts

This setup enables a streamlined discovery process. However, keep in mind that API 
access alone will not provide a complete hardware inventory. For the most accurate 
and detailed results, combine the Prism Central API with SSH access to the physical 
hosts and the CVMs.
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4.5.2.3 Review Nutanix Inventory Results

After scanning a Nutanix environment, the discovered infrastructure can be reviewed 
using the Virtualization Explorer in JDisc Discovery.

Open the Nutanix subtree in the Virtualization Explorer. The structure is similar to that 
of a VMware vCenter environment, making it intuitive for users familiar with virtualized 
infrastructures.

The hierarchy is organized as follows:

● At the top level, the Nutanix Prism Central installation is displayed as the root 
element

● Underneath, all discovered clusters managed by this Prism Central instance are 
listed

● Each cluster contains the associated physical servers (hosts)

● Within each host, the virtual machines (VMs) running on that server are shown

This structured view allows for quick navigation and a clear understanding of how 
resources are grouped and managed within the Nutanix infrastructure. It provides a 
centralized and consistent way to explore virtual environments, supporting both 
operational insight and documentation.

4.6 Discovery Using Jumphost

There are cases, where you don't have direct access to a server. In many cases, 
administrators use a dedicated so called jumphost to access the server. In order to 
logon to the server, you connect first via SSH to the jumphost and then use the ssh 
client to access the actual server.
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Figure: Scan a device via Jumphost

Define a jumphost for a dedicated network or IP range. In order to scan a device within 
this network or range, JDisc Discovery will connect to the jumphost first and then 
connect to the final server.

JDisc Discovery will also make use of the jumphost to ping the target network because 
ping to those protected networks is often blocked by a firewall.

There are two options on how to use the jumphost:

● try first a direct connection. If that fails, then use the jumphost.

● always use the jumphost.

Define a jumphost for an IP4 subnetwork or for an IP4 range from within the discovery 
configuration dialog.
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Figure: Jumphost Configuration

Click on the Jumphost button in order to define a jumphost for a specific IP4 network or 
range. Configure the jumphost access credentials and the jumphost mode.

Figure: Jumphost Configuration Dialog

Use the Test button in order to test access to the jumphost.

4.7 Discover Cloud Environments

JDisc Discovery discovers cloud infrastructures for selected cloud provider.

4.7.1 Microsoft Azure

JDisc Discovery can gather information about Microsoft's Azure cloud. That includes 
information about Office 365 deployments as well as virtual machines and database 
services.

JDisc Discovery basically requires the following rights:
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● DeviceManagementManagedDevices.Read.All (Type Application) to read Intune managed 
devices

● DeviceLocalCredential.Read.All (Type Application) in order to read the local 
administrator password when devices use LAPS within Intune.

● Directory.Read.All (Type Application) in order to read directory information
● User.Read.All (Type Application) in order to read user information
● AuditLog.Read.All (Type Application) in order to read last logon date of users
● Furthermore, you need read access to each and every subscription that you would like to 

read.
4.7.1.1 Preparation Within The Azure Portal

You need to create an application within the Azure portal in order to collect Microsoft 
Azure information. Basically, you have to

● Register a new application

● Create a secret key

● Grant read access to users with the User.Read.All permission within the Microsoft 
Graph API

● Grant read access to Azure Active Directory with the Directory.Read.All permission 
within the Microsoft Graph API.

●

● Grant reader permissions to the individual subscriptions from the Access Control 
(IAM) dialog for each subscription.

● Grant permissions to Intune by adding the permission 
DeviceManagementManagedDevices.Read.All permission within the Microsoft 
Graph API

Follow the steps below to create an application with the required permissions:

● Connect to the Azure portal

● Open Azure Active Directory > App Registrations

● Click on New application registration

● Enter a name (e.g. JDisc Discovery)

● Enter https://localhost as Sign-on URL

● Once the application is created copy the Application ID to a Notepad window

● Now, we need to configure the api secret and the permissions

● In the application properties click on the Settings button

● Then click in the right menu on Keys

● Enter a new description for the key and a duration

● Once it is saved, copy the key secret to your notepad. The key secret is only visible 
once. If you don't have the key secret anymore, then you need to delete the key 
and create a new one
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● Within the application settings click on the Required permissions item

● Click on Add and then  select the Microsoft Graph API.

● Select Application Permissions and select the item Read Directory Data 
(Directory.Read.All)

● Select Application Permissions and select the item Read Domain Data 
(Domain.Read.All)

● Select Application Permission and select the item Read all users' full profiles 
(User.Read.All)

● In addition add the permission Read Microsoft Intune Devices 
(DeviceManagementManagedDevices.ReadAll) when you are using Microsoft 
Iontune.

● Click on Grant admin consent for <directory name>

● Finally, you need to grant read access to every subscription that you would like to 
discover:

● Open your subscriptions (e.g. from the Cost Management + Billing

● Select the desired subscription.

● Now select the item Access Control (IAM) in the left hand menu

● Click on Add a role assignment

● Select the role reader

● In the Select input field enter the name for the registered application, select the 
application and save your settings.

4.7.1.2 Configuration Within JDisc Discovery

Configure Microsoft Azure cloud access within JDisc Discovery once you have 
completed the preparation steps from the previous chapter. You will need:

● The so called tenant id. The tenant id might also be called directory id

● The application id

● The key secret

You can get the tenant id from the Azure portal within the Active Directory/Properties 
tab. The application id and the key secret is available from the your steps when you 
registered the application.

Enter the Azure cloud information in the configuration dialog.
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Figure: Add access credentials for an Azure cloud directory

You might enter access credentials to more than one Azure cloud 
directory!

Define for each discovery job whether cloud information should be updated within this 
job or not.

Figure: Enable Cloud Synchronization for a Discovery Job
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Not every discovery job needs to update the cloud information. In 
some cases, a separate job which updates the cloud information on 
a daily or weekly base might be sufficient!

Check the cloud discovery state from within the cloud status tab once the discovery job 
has started.

Figure: Cloud Discovery Status

4.7.1.3 Checking Azure Cloud Results

The Microsoft Azure discovery performs two major tasks:

● it reads Office 365 subscriptions

● for each subscription, JDisc Discovery gets the list of subscribed services (e.g. 
database services, virtual machines)

Review the list of Office 365 subscriptions from the report Cloud » Office 365 » Office 
365 Subscriptions. Open the report Cloud » Office 365 » Office 365 User Subscriptions  
in order to list of Azure directory users together with their Office 365 subscriptions.

The Cloud Explorer which is available through Cloud » Cloud Explorer organizes the 
cloud information in a tree. The top level item defines the Cloud technology, the next 
level determines the tenant (the owner of the cloud). Below the tenant there is 
information about the Office 365 subscriptions as well as the Azure subscritpions and 
their assigned resource groups and resources.
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Figure: The Cloud Explorer

4.7.2 Amazon AWS

JDisc Discovery can gather information about Amazon's AWS cloud. That includes 
information about virtual machines.

4.7.2.1 Preparation Within The AWS Portal

You need to create an application API key and an API key secret within the Amazon 
AWS portal in order to collect cloud information:

● Open the IAM service within your AWS portal.

● Go to the users

● Create a new user and select the Security credentials tab.

● Within this tab use the button Create access key and remember the Access key ID 
and the Secret access key. 

The Secret access key is displayed only during the key creation 
and cannot be recovered afterwards. So make sure to take a note 
of the key.

4.7.2.2 AWS Permissions Required For Cloud Discovery

To enable JDisc Discovery to collect information from your AWS environment, the IAM 
user or role configured in the Cloud Account settings must have read-only permissions 
to access specific AWS services. These permissions allow JDisc to retrieve metadata 
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from resources such as RDS instances, S3 Buckets, Elastic Load Balancers and EC2 
instances without modifying or creating anything in your AWS account.

At minimum, the following AWS API permissions, must be included in the IAM policy:

● RDS: rds:DescribeDBInstances, rds:DescribeDBClusters, rds:ListTagsForResource

● S3: s3:ListAllMyBuckets, s3:GetBucketLocation, s3:GetBucketTagging, 
s3:ListBucket

● Load Balancer: elasticloadbalancing:DescribeLoadBalancers, 
elasticloadbalancing:DescribeTags, elasticloadbalancing:DescribeTargetGroups

● EC2 (for target groups): ec2:DescribeInstances, ec2:DescribeTags

These can be attached to a custom IAM policy and assign it to the role or user used in 
JDisc Discovery. We recommend applying the principle of least privilege to maintain 
security while enabling full discovery functionality.

 

Figure: Amazon AWS Policies

4.7.2.3 Checking Amazon AWS Cloud Results

JDisc Discovery checks all AWS regions and collects all virtual machine resources 
assigned to the region together with the resource groups. Furthermore, it discovers all 
tags attached to a VM and stores them within the custom attribute section.
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Figure: Amazon AWS Results

4.7.3 Google Cloud Platform

JDisc Discovery can gather information about the Google Cloud Platform. That includes 
information about the cloud structure (folders, projects, regions, and zone) as well as 
information about the hosted virtual machines.

4.7.3.1 Preparation Within The Google Cloud Platform

First, enable the required APIs for your projects:

● Compute Engine API

● Cloud Resource Manager API

Create a Service Account within the API section. The service account requires the 
following permissions on the organization and the projects:

● Browser

● Viewer

Finally, create a Key for the service user. Use the JSON format when creating the key.

4.7.3.2 Configuration Within JDisc Discovery

Open the discovery configuration and select the Google Cloud Platform tab within the 
Cloud section.

Click on add and provide the following information:

● name: Choose a name for this connection

● domain name/directory customer id: provide the google domain name or the 
directory customer id

● api key: Past the JSON key created in the Google Cloud Platform configuration.

Use the Test button in order to test your configuration.

4.7.3.3 Review Google Cloud Platform Scan Results

After a successful scan review your cloud information using the Cloud Explorer.
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Figure: Google Cloud Platform Scan

4.7.4 Cisco Meraki

JDisc Discovery can gather information about the Cisco Meraki cloud. That includes 
information about the managed network devices, organizations and networks.

4.7.4.1 Preparation Within The Cisco Meraki Portal

You need to create an application API key within your Meraki portal. Configure this 
account within the Cloud configuration tab.
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Figure: Configure the API key for the Cisco Meraki Discovery

4.7.4.2 Checking Cisco Meraki Cloud Results

Cisco Meraki devices can be scanned directly via SNMP or via the cloud using Meraki's 
REST API. The REST API gets information that is not available via the SNMP protocol 
such as serial numbers for access points, assigned organizations or Meraki networks.

Figure: Meraki Discovery Results
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4.8 Discover Users And User Groups

JDisc Discovery discovers local user and user groups from computers and global users 
and user groups from Microsoft Active Directory. Moreover JDisc Discovery also 
gathers additional user and user group information including group members.

User and user group discovery is enabled by default. Two settings allow to to enable or 
disable the discovery of users and user groups.

Most reports that display users and user groups provide buttons on the right pane. 
These buttons simplify the navigation from user groups to their members or displaying 
effective permissions when the Security add-on is installed and licensed.

JDisc Discovery Discovers users, user groups and user group 
membership  from computers and Microsoft Active Directory.

4.8.1 Discover Local Users And User Groups

JDisc Discovery discovers local users and user groups for Windows and Unix 
computers. The discovery f local users and user groups is enabled by default and can 
be disabled from the discovery settings in the Data Collection tab.

Figure: User / User Group Data Collection Settings

4.8.2 Discover  Active Directory Users And User Groups

When Microsoft Active Directory access has been configured (refer to chapter 4.1 for 
more details), JDisc Discovery discovers all users and user groups that exist in Active 
Directory. Furthermore, JDisc Discovery assigns all users and user groups to their 
respective directory object and builds the user group membership of all users and user 
groups.

To discover Active Direcory users, user groups and user group membership,  the 
synchronize users and synchronize user groups options must be enabled in the 

- 92 -



Discovery Jobs directory tab.

Figure: Directory Synchronization Settings

4.8.3 The User Group Browser

JDisc Discovery's user group browser displays the group hierarchy in a tree view. A 
report in the main area shows all users and user groups that belong to the selected 
group in the tree.

Figure: User Group Browser
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4.8.4 User Report

Open the Users » Users menu item to display global Active Directory users.

Figure: User Report

Use the buttons on the right side to display the user groups of which the user is a 
member.

4.8.5 User Group Report

Open the Users » User Groups menu item in to display allglobal Active Directory users 
groups.
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Figure: User Group Report

Use the buttons on the right side to display  member users and user groups.

The user report does not display local user groups but only global 
Active Directory user groups.

4.9 Discover Databases

JDisc Discovery detects database installations together with the list of running 
instances, databases, its sizes and tables for a variety of database products.

The database discovery is split into two phases. Within the first phase, we are going to 
identify the database installations by looking at processes, installed applications or the 
Windows registry. 

Once, we have determined the database installations and the ports that the instances 
are running on, we connect via JDBC to the database and determine information about 
the database itself. We collect information about its size, the schemas and tables 
defined within the database.

4.9.1 Configure Database Accounts

As for scanning devices, we need access credentials in order to connect to a database 
instance. Open the Discovery Configuration dialog and select the Accounts tab within 
the Scope. There, you can define default accounts for the currently supported 
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databases. Note that JDisc Discovery uses the database's JDBC driver to connect to 
the database.

If the connection succeeds, then we remember the username and password of the last 
success. This avoids to test the whole default list for each and every scan. The 
discovery will be faster and security logs shorter.

Database instances can be scanned without direct access to the 
database while more detailed information such as database size, 
schemas and tables requires database access via JDBC.

The database discovery requires to leave the process discovery 
enabled because some databases can only be identified based on 
their processes.

Figure: Configure Default Database Accounts

The default accounts will be used to connect to a database for the given database  
system.

4.9.2 Review Database Discovery Results

JDisc Discovery assigns the discovered database information to the corresponding 
devices. Database information is available from within the device details dialog.
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Figure: Database Details

JDisc Discovery offers a tree version for the database report and a flat version which 
lists all database information in one single table.

4.9.3 Discover Oracle Database Instances

JDisc Discovery discovers Oracle database instances on Unix and Windows operating 
systems and stores them as application instances of type 'Database'.

4.9.3.1 Discover Oracle Instances On Unix Computers

JDisc Discovery requires remote login to discover Oracle database instances. Make 
sure you have enabled remote login for the desired platform and have entered access 
credentials. Root access is required to query all Oracle database instances.

Root access is required to query all Oracle database instances.

4.9.3.2 Discover Oracle Instances On Windows Computers

JDisc Discovery requires 

● Windows Remote Login

● WMI

● SMB

protocols to collect Oracle database instances. Make sure you have enabled these 
protocols and entered access credentials.

4.9.3.3 Oracle Multitenant Databases From Version 12c

Since Oracle Database version 12c Release 1, oracle introduced the concept of 
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multitenant architecture which enables an Oracle database to function as a multitent 
container database (CDB).

In order to be able to scan Oracle multitenant databases in JDisc Discovery, you need 
to add 'sys as dba' account to JDisc Discovery in configuration under Scope > Accounts 
> Database > Oracle Database.

Figure: Database Instances

Administrative remote login, WMI and SMB is required to collect 
Oracle database instances.

4.9.4 Discover Oracle MySQL Database Instances

JDisc Discovery discovers Oracle MySQL database instances on Unix and Windows 
operating systems and stores them as application instances of type 'Database'.

4.9.5 Discover IBM DB2 Database Instances

JDisc Discovery discovers IBM DB2 database instances on Unix and Windows 
operating systems and stores them as application instances of type 'Database'.
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4.9.5.1 Discover IBM DB2 Instances On Unix Computers

JDisc Discovery requires remote login to query DB2 database instances. Make sure 
you have enabled remote login for the desired platform and have entered access 
credentials.

Root access is required to query all DB2 database instances.

4.9.5.2 Discover IBM DB2 Instances On Windows Computers

JDisc Discovery requires  

● Windows Remote Login

● WMI

● SMB (authenticated)

protocols to collect IBM DB2 database instances. Make sure you have enabled these 
protocols and entered access credentials.

Administrative remote login, WMI and SMB is required to collect 
IBM DB2 database instances.

4.9.6 Discover Microsoft SQL Server Instances

JDisc Discovery discovers SQL Server database instances and stores them as 
application instances of type 'Database'.

JDisc Discovery requires 

● SMB (authenticated)

● WMI

to collect Microsoft SQL Server instances. Make sure you have enabled these protocols 
and have entered access credentials.

SMB or WMI access is required to collect Microsoft SQL server 
instances.

4.9.7 Discover Postgres Database Instances

JDisc Discovery discovers Postgres database instances on Unix and Windows and 
stores them as application instances of type 'Database'.

- 99 -



4.9.7.1 Discover Postgres Instances On Unix Computers

JDisc Discovery requires remote login to query Postgres database instances. Make 
sure you have enabled remote login for the desired platform and have entered access 
credentials. Root access is required to query all Postgres database instances.

Root access is required to query all Postgres database instances.

4.9.7.2 Discover Postgres Instances On Windows Computers

JDisc Discovery requires 

● Windows Remote Login

● WMI

● SMB

protocols to discover Postgres database instances. Make sure you have enabled these 
protocols and entered the required access credentials.

Administrative remote login, WMI, SMB access is required to 
discover Postgres database instances.

4.9.8 Discover Sybase Database Instances

JDisc Discovery discovers Sybase database instances on Unix and Windows 
computers and stores them as application instances of type 'Database'.

4.9.8.1 Discover Sybase Instances On Unix Computers

JDisc Discovery requires remote login to discover Sybase database instances. Make 
sure you have enabled remote login for the desired platform and have entered access 
credentials.

4.9.8.2 Discover Sybase Instances On Windows Computers

JDisc Discovery requires SMB or WMI to query Sybase database instances. Make sure 
you have enabled at least one of those protocols and that you have entered access 
credentials.

4.10 Running Oracle LMS Scripts

JDisc Discovery can run Oracle's LMS scripts in order to help collecting the data when 
audited by Oracle. Oracle usually provides the LMS scripts within a ZIP package. The 
ZIP package includes some documentation and the Unix shell and Windows command 
scripts.
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JDisc Discovery cannot prepackage Oracle's scripts because of Oracle's licensing 
terms. However, if you are audited by Oracle, then you are entitled to receive the 
scripts. Once you receive the scripts, you can integrate the scripts into JDisc Discovery. 
JDisc Discovery will then copy the scripts to a target machine that has an Oracle 
database installed, runs the scripts and collects the output files as custom attributes 
within our database.

4.10.1 Import Oracle LMS Scripts Into JDisc Discovery

Copy the Oracle LMS scripts to your JDisc Discovery server. Then open the 
configuration dialog and navigate to Data Collection » Database in order to import the 
Oracle LMS scripts into JDisc Discovery. First enable the Oracle LMS collection by 
selecting the checkbox Run Oracle LMS scripts. Then click on the Browse button and 
select the Oracle LMS zip file.

JDisc Discovery is now prepared to run Oracle's LMS scripts.

Figure: Configuring Oracle LMS Data Collection

4.10.2 Review The Results

You find the output for the Oracle LMS collection within our custom attribute section 
once a server with an Oracle database installation has been scanned.

Figure: Oracle LMS Results
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As a result of an Oracle LMS script execution, you get a hierarchy of folder below the 
Oracle LMS root folder. The folder structure below is that we create a new folder for 
each result ZIP file that comes from the LMS scripts. Then, we create the exact same 
folder structure as it is within the result ZIP files from Oracle's scripts.

4.10.3 Bulk Export

When the Oracle LMS data has been imported into JDisc Discovery's database, then 
you can select any number of devices and use the context menu Oracle LMS » Export 
Oracle LMS Data. The export creates a ZIP file with a folder for each device. Each 
device folder contains all files collected for this particular device.

4.11 JEE Server Discovery

JDisc Discovery detects the most common Java Enterprise Edition (JEE) application 
server. In addition to finding the application server software installation, JDisc Discovery 
also discovers all deployed JEE applications. JEE applications are represented as 
application instances in JDisc Discovery's reports.

4.11.1 IBM WebSphere

JDisc Discovery requires remote login access on Unix and Windows systems to 
discover IBM WebSphere installations (starting with WS 7.0).

4.11.2 Oracle WebLogic

JDisc Discovery requires remote login access on Unix and Windows to discover  Oracle 
WebLogic installations. On Unix, root access is required due to restrictive permissions 
configured by Oracle's installer program.

4.11.3 JBoss

JDisc Discovery requires remote login access on Unix and Windows to discover JBoss 
installations.
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4.12 Using Password Managers

JDisc Discovery can use password managers to obtain the current username and 
password for a specific device during the scan process.

4.12.1 Paswordstate

Clickstudios' password manager Passwordstate offers a wide range of functionality to 
manage your passwords, rotate passwords on defined intervals.

4.12.1.1 Prepare Passwordstate Server

In order to obtain data from the Passwordstate solution via its API, you need to define 
API keys. There are two kind of API keys:

• Systemwide API Keys
There can only be one systemwide API key in Passwordstate. With this API key, 
users can obtain data from all shared password lists.

• API Keys for single Password Lists
API keys for single password lists can be defined when you would like to grant 
access only to this particular password list.

4.12.1.2 JDisc Discovery Configuration Steps

In order to configure access to the Passwordstate solution, you need to have the 
following information:

• The Passwordstate's server name (e.g. passwordstate.testcompany.com)

• The port that the API is reachable on (usually 443)

• A systemwide API key or a list API key together with the numeric list id.

When configuring access to a single Password list then you need 
the API key for the list and the internal list id from Passwordstate.
The list ids are hidden by default. Enable displaying the list id by 
using the List Administrator Actions... within the list properties and 
choose the option Toggle Visibility of WEB API IDs.

Once you have this information, you can add a Passwordstate connection in JDisc 
Discovery's user interface via  Administration » Password Managers » Passwordstate.

Figure: Configure Passwordstate Connections

The menu item opens a new dialog with the list of currently configured connections. 
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Add a new connection via the Add button.

Figure: Add a systemwide Connection

Once, you have added the new connection, you can use the Test button to check 
whether the connection works or not.

Choose the credentials you would like to use within the discovery when the connection 
to the Thycotic SecretServer has been established.

Choose Accounts from the Passwordstate Password Manager

4.12.2 Thycotic SecretServer

Thycotic's SecretServer is a password management product which is frequently used 
by companies to manage their credentials in a secure way.

4.12.2.1 Prepare Thycotic SecretServer

In order to use the Thycotic's REST API, you will need to define a user with a username 
and password which has the permissions for API access. Follow the Thycotic 
instructions on how to achieve this.

4.12.2.2 JDisc Discovery Configuration Steps

Once the Thycotic SecretServer is properly configured, you can add the Thycotic 
SecretServer connection to JDisc Discovery.

Open the Thycotic SecretServer connection management dialog via Administration » 
Password Managers » Thycotic.

Figure: Configure Thycotic Secret Server Connections
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This menu item opens a new dialog which allows users to manage your Thycotic 
SecretServer connections.

Figure: Add a new Thycotic SecretServer Account

Choose the credentials you would like to use within the discovery when the connection 
to the Thycotic SecretServer has been established.

Figure: Choose Credentials

JDisc Discovery will query the Thycotic SecretServer for the current login and password 
when the credentials are needed for the device scan. JDisc Discovery does not store 
the username or passwords in its database!

4.12.3 CyberArk

CyberArk is a password management application which is frequently used to store and 
manage access credentials for devices or domains. In order to use the CyberArk 
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password manager, you need to prepare the CyberArk server and configure access for 
the JDisc Discovery  solution.

4.12.3.1 Prepare CyberArk

Follow the steps below in order to provide access to the credentials stored within 
CyberArk.

Step 1: Define an Application ID
To define the application, define it manually through the CyberArk Password Vault Web 
Access (PVWA) interface:

● Log in as user allowed to manage applications (it requires Manage Users 
authorization)

● In the Applications tab, click Add Application. The Add Application page appears.

There is no special requirement for the APPID name. Specify the following information:

● in the Name box, specify the unique name (ID) of the application. The 
recommended Application ID for this integration is:APP ID = Jdisc

● in the Description box, specify a short description of the application that will help 
you identify it. 

● in the Business owner section, specify contact information about the application’s 
business owner. 

● in the Location box, specify the location of the application in the Vault hierarchy. If a 
location is not selected, the application will be added in the same location as the 
user who is creating this application.
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Figure: Adding an Application

Click Add and the application is added to the list of applications.

Figure: Application Configuration

● check the Allowing extended authentication restrictions box. This enables you to 
specify an unlimited number of machines and Windows domain OS users for a 
single application.

● Specify the application’s Authentication details. This information enables the 
Credential Provider to check certain application characteristics before retrieving the 
application password. 
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Step 2: Specify Authentication Details
Specify the application’s Authentication details. This information enables the Credential 
Provider to check certain application characteristics before retrieving the application 
password. You need to create a client certificate and you have to have the root 
certificate for the client certificate.

● in the Authentication tab, click Add. A drop-down list of authentication characteristics 
is displayed. 

● Select Certificate Serial Number

● Specify the Certificate Serial Number.

Optional Step 3: Specify the Allowed Machines
Specify the application’s Allowed Machines. This information enables AAM to make 
sure that only applications that run from specified machines can access their 
passwords. 

● In the Allowed Machines tab, click Add. The Add allowed machine window is 
displayed.

Figure: Enter allowed machine

● In the Address box, specify the IP/hostname/DNS of the machine where 
the application will run and will request passwords, then click Add. The IP 
address is listed in the Allowed Machines tab.

Step 4: Provisioning Accounts and setting Permissions for Application Access
For the application to perform its functionality or tasks, the application must 
have access to particular existing accounts, or new accounts to be 
provisioned in CyberArk Vault. 

In the Password Safe, provision the privileged accounts that will be required 
by the application. You can -do this in either of the following ways:

● Manually – Add accounts manually one at a time, and specify all the account 
details.

● Automatically – Add multiple accounts automatically using the Password 
Upload feature.

For this step, you require the Add accounts authorization in the Password 

- 108 -



Safe. 

For more information about adding and managing privileged accounts, refer 
to the Privileged Access Security Implementation Guide.

Once the accounts are managed by CyberArk, make sure to setup the 
access to both the application and CyberArk Application Password Providers 
serving the Application.

Add the provider user (where the Central Credential Provider is installed) 
and application users as members of the Password Safes where the 
application passwords are stored. This can either be done manually in the 
Safes tab, or by specifying the Safe names in the CSV file for adding multiple 
applications.

Add the Provider user as a Safe Member with the following authorizations:

● List accounts

● Retrieve accounts

● View Safe Members

When installing multiple Providers for this integration, it is 
recommended to create a group for them, and add the group to the 
Safe once with the above authorization.
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Configuring Application Permissions

Add the application (the APPID) as a Safe Member with the following authorizations:

● Retrieve accounts

If the Safe is configured for object level access, make sure that 
both the provider user and the application have access to the 
password(s) to retrieve.

For more information about configuring Safe Members, refer to the Privileged Access 
Security Implementation Guide.

4.12.3.2 JDisc Discovery Configuration Steps

Once your CyberArk Instance is configured, you have to configure the CyberArk access 
within the JDisc Discovery application. JDisc Discovery can use as many CyberArk 
servers as needed. Each server instance has its own access credentials and 
configured application. Follow the steps below in order to add a new CyberArk server 
instance to JDisc Discovery's configuration:

Open the CyberArk server configuration dialog via Administration > Password 
Managers > CyberArk.
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Figure: Open the CyberArk Server Configuration Dialog

This is going to open the CyberArk Server Configuration dialog. The dialog lists all 
currently configured CyberArk servers.

Figure: CyberArk Servers Dialog

Click on the Add button in order to add an additional CyberArk server. Then enter a 
name for the server, the server address (hostname or IP address), the port (default it 
HTTPS port 443). Finally configure the application id configured in the CyberArk 
preparation.

Furthermore import the client certificate by clicking on the click to import certificate file. 
The file must be in the .p12 format and include the client certificate and the certificate's 
private key.

The root certificate for the client certificate must be imported into 
certificate store on the server where JDisc Discovery is installed.

Figure: Add a new CyberArk Server Connection

The App-ID and the client certificate is used to retrieve the current credentials. In order 
to list the CyberArk accounts and the safes, you need to specify an additional user.

Depending on the user configuration within CyberArk, you can choose an 
authentication type:

● CyberArk
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● Windows

● LDAP

● Radius

In order to get the username and password for this user, you can specific the username 
and password directly or you can specify a CyberArk safe and object name to define 
the credentials.

Finally, you can use the Test button to check the connectivity. In order to check the 
connectivity, you need to provide a safe and object name to test the access with.

4.12.3.3 Using CyberArk Accounts

Once the connection has been established successfully, you can use CyberArk 
accounts from virtually anywhere where you configure access credentials (just a few 
exceptions).

All credential dialogs supporting password managers have now a radio button to 
choose whether you would like to enter a username/password combination or whether 
you would like to choose credentials managed by a password manager.

Figure: Credential Dialog supporting Password Managers

Either enter a username and password or select the User password manager radio 
button in order to select credentials managed by a password manager.
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Figure: Select Password Manager Credentials

The Managed Passwords area contains the selected password from a password 
manager. Click on the undefined – click to modify link in order to select the desired 
credentials.

This will open a selection dialog where you can see the configured password managers 
on the left and once you select a safe the list of the actual passwords on the right side.

Figure: Select the desired Credentials

Finally, the credentials dialog displays the password name.

Figure: The selected Credentials

From now on, the discovery will use this account and query the current username and 
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password from the CyberArk server when the account is needed.

4.12.4 Microsoft LAPS

Microsoft LAPS (Local Administrator Password Solution) is a solution from Microsoft to 
manage local administrator account passwords for computers that are member  of a 
Active Directory. LAPS makes local administrator accounts more secure since it is 
using different passwords for local administrators on different computers and it is able 
to change the passwords frequently.

Find more information on Microsoft's LAPS download page: 
https://www.microsoft.com/en-us/download/details.aspx?id=46899

4.12.4.1 LAPS Architecture Overview

Legacy LAPS To use LAPS, you need to install the software on one of your 
servers. As a second step, you need to extend your directory 
structure with the LAPS related attributes. Finally, you need 
to install a software on all the client computers that are 
managed through LAPS.

Native LAPS Natively Integrated on Windows 11, Windows 10, and 
Windows Server (starting in April 2023)

When configured properly, LAPS updates the local administrator user's password in the 
Active Directory computer account property that is accessible only for specific users. 
Native LAPS also supports encrypted storage of the local administrator passwords in 
Active Directory.

4.12.4.2 Configure LAPS In JDisc Discovery

JDisc Discovery's discovery configuration dialog includes the LAPS tab within the top 
level group. When the Active Directory structure has been synchronized you can view 
all directory objects in the tree view. To make use of LAPS for a directory object, you 
need

● a user account having access rights for reading the local administrator's password 
for computer  accounts. This user account can be assigned on any level in the 
directory and is valid for all sub-directory objects.

● for Legacy LAPS installations only: optionally a list of common local administrator 
account names. This list can be assigned on any level in the directory and is valid 
for all sub-directory objects.  This is important, since the local administrator account 
names can be renamed and also depend on the Windows operating system 
language. If omitted, Administrator is used as local account name.

JDisc Discovery uses LAPS only when discovering computers that are a member of a 
directory object that has been enabled for LAPS (either directly or indirectly via one of 
its parents).
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4.12.4.3 Configure A LAPS Account

To access the local administrator password of a computer account in Active Directory, a 
user is required having also the read the confidential attribute permissions.

 

Microsoft provides a PowerShell helper to delegate exactly the 
needed permission: Set-LapsADReadPasswordPermission 
(point it at the organization unit and the user/group you want to 
allow).

To configure a LAPS account,

• Open the Discovery Configuration dialog-box and switch to the LAPS tab.

• Then select a directory object and click the Change LAPS Account button.

• From the Modify Directory Object Account dialog-box enter the user account and 
password.
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For native LAPS, if the computer running JDisc Discovery is not 
part of the same Active Directory domain, or is operating as a 
standalone system, additional configuration is required:

The LAPS account must have sufficient privileges to execute 
processes on the domain controllers that manage the Active 
Directory domain. JDisc Discovery relies on its Zero-footprint agent 
installed on the domain controllers to decode and decrypt the LAPS 
account password cipher-text stored in the corresponding Active 
Directory computer account object.

Detailed instructions for configuring the Zero-footprint agent’s 
privilege elevation feature—while minimizing the security impact on 
domain controllers - can be found in the JDisc Discovery Security 
Guide, chapter “Communication and Security.”

Figure: Enter a LAPS Account

4.12.4.4 Configure Local Administrator Accounts

Without extra configuration, JDisc Discovery uses ADMINISTRATOR as default login 
for the local administrator. 

You must enter a different local administrator account name (or a list of local 
administrator account names) if the local administrator login is localized or has been 
intentionally renamed.

To enter local administrator account names, 

• select a directory object and click the Local Administrator Accounts button to 
manage the list of local administrator account names.

• from the LAPS Local Administrator Account Names dialog-box, click Add to add 
a new local administrator account name or Remove to delete an existing local 
administrator account name. 
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Figure: Manage LAPS local Administrator account names

4.12.5 Microsoft Group Managed Accounts (gMSA)

A Group Managed Service Account (gMSA) is a domain-managed account designed for 
use across multiple Windows computers, offering automated password management, 
streamlined handling of service principal names (SPNs), and support for delegating 
administrative control to other users.

As the name implies, it involves a global Windows domain group, which includes a set 
of Windows computer accounts that are permitted to retrieve the gMSAs password. 
Moreover, a gMSA must be installed on a computer to enable that computer to 
authenticate using the account.

The figure below illustrates a typical gMSA Windows ecosystem:
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Figure: Windows Group Managed Service Account gMSA Ecosystem

This chapter does not provide a comprehensive guide on creating, configuring, 
and installing a gMSA on Windows computers in a domain environment. The 
JDisc website features a collection of blog articles on gMSA that offer further 
insights and context.

4.12.5.1 Add A GMSA To The Discovery Configuration

Including a gMSA in the directory discovery configuration is the simplest approach.

From the Discovery Configuration dialog-box, navigate to the Scope > Directory tab 
and select the directory objects where the gMSA should be configured as the access 
credential for the discovery.
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Figure: Discovery Configuration using a Group Policy Managed Account

After making your selection, click the Change Account button to open the Modify 
Directory Object Account dialog-box.
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Figure: Adding a gMSA in the Directory Object Account dialog

Enter the gMSA in the User name field, appending a dollar sign ($) to ensure it is 
interpreted correctly as a gMSA by the discovery process.

Leave the Password field blank, as the gMSA password is fetched dynamically by the 
system during authentication.

Make sure the gMSA is installed on all machines within the selected directory 
objects for everything to work properly.

The figure below shows an example of a gMSA environment setup

Figure: An example of a Group Policy Managed Service Account setup

The discovery server must also be a member of the global gMSA-User-Group 
to authenticate properly.
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4.13 Cluster Discovery

JDisc Discovery identifies several cluster technologies.

4.13.1 Veritas Cluster

JDisc Discovery requires remote login access on Unix and Windows to discover Veritas 
cluster installations. JDisc Discovery identifies the cluster name and the cluster 
services including their status.

4.13.2 Microsoft Cluster Services

JDisc Discovery requires WMI access to identify Microsoft Cluster Services 
installations. JDisc Discovery identifies the cluster name and the cluster services 
including their status.

4.13.3 HP ServiceGuard Cluster

JDisc Discovery requires remote login access to detect HP ServiceGuard cluster 
installations. JDisc Discovery identifies the cluster name and the cluster services 
including their status.

4.13.4 Cisco HSRP Cluster

JDisc Discovery requires SNMP access to detect Cisco's HSRP Cluster.

4.13.5 VRRP Cluster

JDisc Discovery requires SNMP access to identify VRRP cluster for switches and 
routers.

4.13.6 Fortinet HA Cluster

JDisc Discovery requires SNMP access to identify Fortinet HA cluster for switches and 
routers.
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4.13.7 Juniper HP Cluster

JDisc Discovery requires SNMP access to identify Juniper HP cluster for switches and 
routers.

4.13.8 Unix Cluster

JDisc Discovery requires SSH or telnet access in order to identify Solaris, Redhat, 
Citrix, VMware, KVM, AIX and Pacemaker clusters.

4.14 Client Access License Discovery

A Client Access License (CAL) is a type of license that grants permission to access or 
use a specific software product or service. CALs are commonly used in client-server 
computing environments, particularly in enterprise environments. 

There are typically two types of CALs:

1. User CAL: This type of CAL is assigned to individual users. With a User CAL, 
the licensed user can access the server from any device they use, such as their 
work computer, laptop, or mobile device.

2. Device CAL: This type of CAL is assigned to a specific device, such as a 
computer or a smartphone. With a Device CAL, any user who accesses the 
server from the licensed device is covered.

When a Client Access License (CAL) is assigned to an individual user or a specific 
device, it becomes an Issued Client Access License (ICAL) and is removed from the 
pool of available CALs. Typically, ICALs are issued for periods of 1-2 months and are 
revoked and returned to the CAL pool when no longer used by the assigned user or a 
specific device.

JDisc Discovery can discover Client Access Licenses (CALs), Issued Client Access 
Licenses (ICALs) and CAL license servers for Windows Remote Desktop Services 
environments. 

4.14.1 Configuration

To enable client access license discovery, select “Discover Client Access Licenses” on 
the Data Collection > Software tab of the “Discovery Configuration” dialog box.
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 Figure: Client Access License Configuration

Client Access License discovery for Remote Desktop Services 
needs  the WMI (Windows Management Instrumentation) protocol 
to query CALs, ICALs and license servers. 

4.14.2 Reporting

The discovery process assigns the “License service” role to servers that run a Client 
Access License service.  The “Devices by Role” report identifies all Client Access 
License Servers via the “License service” role.
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Figure: Devices by Role report

To view Client Access License servers, select “License service” from the “Devices by 
Role” report and then access the “Devices with selected Role(s) from the context 
menu.

Figure: All Devices with Role 'License service' report

Client Access License related information (CALs, ICALs, CAL summary and license 
servers) are available from the “Device Details” dialog-box under the “Software” tab.
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4.14.2.1 Client Access Licenses

The “Client Access Licenses” report displays installed / registered CALs including the 
characteristic attributes such as Version, Product Type, Type and Total Licenses (pool). 

Figure: Client Access License reporting

4.14.2.2 Issued Client Access Licenses

The “Issued Client Access Licenses” report displays CALs (from the pool) that have 
been assigned to individual users or specific devices.

Figure: Issued Client Access Licenses

4.14.2.3 Client Access License Summary

The “Client Access License Summary” report compares the number of installed CALs 
with CALs assigned to individual users or specific devices – the ICALs. 
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Figure: “Client Access License Summary” report 

This report groups all CALs and ICALs by display name and product type (Per Device 
and Per User) and calculates the number of total issued available and installed licenses 
accordingly. 

4.14.2.4 Client Access License Servers

The client access license reports in the previous subchapters show information of  
devices running a license service (the “Remote Desktop Licensing” service). However, 
client access license discovery also identifies which license server is configured for a 
particular service on a device.

Figure: “Client Access License Servers” report

The figure above shows the device “WIN-9FPFDAPN8L0.JDISC-INTERNAL.LOCAL” 
running the “Remote Desktop Services” service, which uses the license server with the 
name/IP address “192.168.32.94”.
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4.15 Microsoft Exchange Server Discovery

JDisc Discovery discovers Microsoft Exchange Server using its zero-footprint agent. 
Once the discovery process has deployed the agent on the exchange server, it runs 
some powershell scripts to retrieve exchange server editions and mailboxes.

4.15.1 Configuration

Microsoft Exchange mailbox discovery is enabled by default. You might modify the 
settings from the Exchange Server tab within the Data Collection area. Gathering the 
mailboxes with their configuration can take some time and the default remote login 
execution timeout might be too short to run the script on weak hardware or on heavily 
loaded servers. Therefore there is a separate timeout value Powershell script execution 
timeout. Its default is 30 minutes. Increase the timeout if you our powershell scripts 
need more time.

Figure: Exchange Server Discovery Configuration

Exchange Server Discovery requires the remote login protocol 
(zero-footprint agent) for Windows. Otherwise, it is not possible to 
run the powershell script locally on the exchange server.

Exchange Server Discovery powershell scripts might need some 
time to retrieve mailbox information on heavily loaded or large 
Microsoft Exchange installations.
Use the Powershell script execution timeout in order to configure 
the timeout for Exchange data collection scripts.
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4.15.2 Exchange Server Reports

Open the Microssoft Exchange server menu item in order to retrieve the list of 
Exchange servers and mailboxes.

Figure: Exchange Server Menu Item

The Microsoft Exchange Server menu item lists all Exchange server, the currently used 
Exchange edition and version together with statistics about the managed mailboxes.

Figure: Exchange Server Report

The Microsoft Exchange Mailboxes report lists all mailboxes found in server farms. For 
each mailbox, it gathers status and configuration information about

● Web Access configuraiton

● Active Sync configuration

● quota information

● mailbox size

Figure: Exchange Mailboxes

4.16 Support Entitlement Discovery

JDisc Discovery gathers warranty and support entitlement information for vendors that 
offer a web based interface to query this information. For most vendors, this does not 
even require access credentials. However for some vendors, this requires an API key 
and API secret or username and password.
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4.16.1 Cisco  Warranty Information

With your company specific Cisco Client ID and Client Secret keys you can gather 
Cisco devices support entitlements about warranty information and coverage. Add your 
access credentials  in Scope > Accounts > Support Entitlement > Cisco Support 
Entitlement > Cisco as 'User name' and 'Password' respectively.

4.17 Multicast MDNS/UPnP Device Discovery

Many home networking and Internet of Things (IoT) devices do not support typical 
management protocols such as SNMP or SSH command shells. 

As a result, such devices often are not found or identified by a central discovery server. 
However, many home networking and Internet of Things (IoT) devices support the 
mDNS or UPnP protocols, which can help discover and identify such devices.

4.17.1  Discovery Process

When JDisc Discovery discovers remote (Windows) computers it can send  mDNS and 
UPnP protocol multicast requests on local IPv4 and IPv6 networks and receive 
multicast replies from mDNS and UPnP-enabled devices. 

Figure: Multicast mDNS/UPnP Discovery Process

The figure above shows the typical multicast-based mDNS/UPnP discovery process 
from the discovery server to a home or branch office.

• [1] The  discovery scans a Windows computer (using remote login) and collects 
the configured data items.
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• [2] Next it sends a mDNS and UPnP multicast discovery request to all local IPv4 
and IPv6 networks.

• [3] mDNS and UPnP enabled devices reply by sending multicasts and the 
Windows computer in the home- or branch office picks device information and 
returns it to the discovery server.

4.17.1.1 IP And MAC Address Resolution

The mDNS and UPnP protocols work on the network layer and thus do not know MAC 
addresses. However, MAC addresses are important for discovery as they identify 
devices (among other attributes).

Therefore, MAC addresses of mDNS and UPnP-enabled devices are resolved using 
the local IPv4 ARP and IPv6 Network Neighbor caches on Windows computers in 
home- or branch offices.

4.17.2 Supported Device Types

Many types of devices can be identified using the mDNS and UPnP protocols. At the 
time of writing the following device types are supported by JDisc Discovery.

• Audio Receiver (Denon)

• Dishwasher (Siemens)

• Home Automation Controller (Elero Centero Home Gateway)

• Home Environment Controller (tado°) 

• Home Lighting Controller (Philips Hue)

• Laptop (Apple MacBook) 

• Multifunctional Device (Brother, Hewlett-Packard)

• NAS (QNAP, Synology)

• Radio Alarm Clock (Philips Wake-up Light)

• Smart TV (LG, Samsung)

• Smart TV Receiver (Apple TV, Telekom)

• Smart Speaker (Bang & Olufsen Beoplay)

• Tablet Computer (Apple iPad)

• Weather Station (Netatmo)

• Wireless DSL Router (AVM Fritz!Box)

• Wlan Repeater (AVM)

4.17.3 Unknown Devices

The mDNS and UPnP protocols are largely based on text information that is processes 
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by the discovery using rules. These rules associate the textual information to device 
types, models, and manufacturers. Because of that, text information from devices that 
are not yet known (for which no rules exist) are set to Unidentified Device. 

To support unidentified mDNS and UPnP devices faster, JDisc Discovery includes two 
new reports. These reports display textual information from the mDNS and UPnP 
protocols for which no rules exist yet.

Support ZIPs include the content of the two reports and help to develop and  improve 
mDNS and UPnP device discovery rules. 

4.17.3.1 Unknown MDNS Devices Report

The device information returned by the mDNS protocol consists of service types and 
properties as shown in the next screenshot. 

Figure: Unknown mDNS Devices Report

The service types and properties, including the values they contain, do not always 
allow a clear assignment to device type, model and manufacturer. 

4.17.3.2 Unknown UPnP Devices Report

The UPnP protocol returns more structured data compared to the mDNS protocol. 
Because of this, creating rules for the UPnP protocol is easier. 

Common attributes are Manufacturer, Model Name, Model Description, Model Number 
and Service Types as shown in the next screenshot. 
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Figure: Unknown UpnP Devices Report

Consequently, it can happen that devices for which the UPnP protocol is successful 
(but no rules exist) are displayed as Unidentified Device but model and manufacturer 
are set. 

Figure: Unidentified UPnP Devices
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The Devices with Discovery Status 'Success' report  shows two UPnP capable devices 
that have no rules yet.

4.17.4 Ignoring Personal Devices In Home Office Environments

Due to the detection of mDNS and UPnP devices, it may now happen that company-
owned and personal devices are included in the company inventory.  

To avoid mixing corporate and personal devices, the discovery of mDNS and UPnP 
enabled devices can be automatically disabled when computers are connected to a 
corporate VPN in a home office environments. 

Figure: Discovery Configuration Data Collection Policies

The new 'Don't discover...' policy setting is enabled by default and avoids mixing 
corporate and personal devices in the inventory. 
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5 Discovery Configuration

The discovery configuration chapter explains the Discovery Configuration dialog in 
detail. Open the Discovery Configuration dialog from Discovery » Configuration. 

The Discovery Configuration consists of eight tabs:

● The General tab allows to configure the maximum number of devices being 
discovered concurrently, global DNS discovery options, ARP cache reading, and 
ignoring recently discovered devices.

● Use the Scope tab to configure IPv4 networks, IPv4 ranges, IPv6 networks, 
Windows network neighborhood objects and directories. Create new groups and 
configure default accounts for SNMP, telnet and SSH.

● Configure DNS domain controllers and credentials in the Directory tab.

● The Data Collection tab allows choose what objects (hardware and software) 
JDisc Discovery should discover.

● The Discovery Jobs tab allow creating, deleting and configuring discovery jobs 
including directory synchronization options. Discovery Jobs can also be 
scheduled.

● Use the Protocols to enable and disable protocols, configure protocol timeouts 
and retries.

● Make use of the Filters tab to restrict the discovery on selected device types and 
exclude IPv4 address ranges.

● Import SSH keys to access devices from the SSH Keys tab.

5.1 General Tab

The general tab hosts these global discovery settings:

● The max. number of devices being discovered concurrently. JDisc Discovery can 
discover devices concurrently speeding up the discovery process. Discovering 
devices concurrently increases network utilization.

● The timeout to abort discovery of devices that do not respond to JDisc Discovery's 
discovery.

● Discover DNS domain controllers is useful for corporate networks running Active 
Directory. If turned on, JDisc Discovery also discovers DNS domain controllers and 
DNS domains when discovering Windows computers. This way JDisc Discovery 
can find unknown Active Directories on the network. 

● Discover DNS servers, if turned on, also discovers DNS servers based on DNS 
domain names of discovered devices. Turn on this option if you are interested in 
what DNS servers exist on the network. 
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● Discover devices found in ARP caches of routers and switches enables JDisc 
Discovery to find IP addresses by reading ARP cache entries of routers and 
switches. Every device running TCP/IP does have an ARP cache. The ARP cache 
maps MAC addresses to IP addresses. Routers typically have high numbers of IP 
addresses in their ARP caches and are a good source to find devices on the 
network.

● Jumphost configuration for improved device and manufacturer identification. JDisc 
Discovery can use jump hosts to identify a device's mac address using the ping and 
arp command on the jumphost.

Figure: Discovery Settings General Tab.

5.2 Scope Tab

The Scope tab allows

● Configuring groups including sub-groups
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● Assigning IP networks, IP ranges, Windows network neighborhood objects and 
directory objects to groups 

● Assigning default credentials to a group

Chapter 3.3 explains JDisc Discovery's grouping concept.

Create groups and sub-groups to fit your need and configure the discovery scope and 
default credentials. 

5.2.1 Scope Tabs

This section explains the sub-tabs within the Scope tab.

5.2.1.1 Properties

The Properties tab allows changing a group's name and description. 

Figure: Properties Tab

5.2.1.2 IPv4 Networks

The IPv4 Networks tab displays IPv4 networks belonging to the selected group. Enable 
IPv4 networks (indicated with the check mark) to ping all IP addresses in the network 
when running a discovery job. Devices will be assigned to selected groups regardless if 
IPv4 networks are enabled or disabled for discovery. 

Use the context menu or the buttons to 

● Enable (using ping), enable (using all protocols) or disable network discovery

● Add new networks

● Browse existing networks

● Remove networks 

● Import networks

IP network numbers are not easy to understand, especially in large corporate and 
enterprise networks that are comprised of hundreds to thousands IP networks. JDisc 
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Discovery allows naming networks. Select a network and enter a name in the name 
column.

JDisc Discovery uses ping in order to find active addresses. However, some networks 
or servers might block ICP ping requests. Devices which do not reply to ping do not 
appear in the database. In this cases, you might enable the network discovery using all 
protocols. JDisc Discovery will then use all protocols (e.g. WMI, HTTP, HTTPS, SMB, 
SSH, telnet...) in order to find active devices. A black square in the checkmark's upper 
left area indicates that a full protocol scan is used.

Figure: IPv4 Networks Tab

Using all protocols to find active devices takes significantly longer 
than simply pinging a network.

Enter a name in the network table's name column.

5.2.1.3 IPv4 Address Ranges

The IPv4 Ranges displays IP4 address ranges belonging to the selected group. Enable 
IPv4 address ranges (indicated with the check mark) to ping all IP addresses in the 
network range when running a discovery job. Devices will be assigned to selected 
groups regardless if IPv4 address ranges are enabled or disabled for discovery. 

Use either the context menu or the buttons to 

● Enable or disable address ranges

● Add new address ranges

● Browse existing address ranges

● Remove address ranges
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● Import address ranges

JDisc Discovery allows naming IP address ranges. Select an address range and enter 
a name in the name column.
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Figure: IPv4 Address Ranges

Enter a name in the IP range table's name column.

5.2.1.4 IPv6 Networks

The IPv6 Networks displays IPv6 networks belonging to the selected group. IPv6 
networks cannot be enabled for discovery. There is because the address range of an 
IPv6 network can become huge and there would be no point to ping all addresses in 
the range. However, devices having IPv6 addresses that are in the scope of configured 
IPv6 networks will be assigned to the selected group .

Use the context menu or the buttons to 

● Add new networks

● Browse existing networks

● Remove networks 

● Import networks

IP network numbers are not easy to understand, especially in large corporate and 
enterprise networks that are comprised of hundreds to thousands IP networks. JDisc 
Discovery allows naming networks. Select a network and enter a name in the name 
column.
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Figure: IPv6 Networks Tab

Enter a network name in the network table's name column.

5.2.1.5 Network Neighborhood

The Network Neighborhood tab displays Windows network neighborhood objects 
belonging to selected groups. Enable Windows network neighborhood objects 
(indicated with the check mark) to discover member computers. Computers will be 
assigned to selected groups regardless if Windows network neighborhood objects are 
enabled for discovery. 

Windows network neighborhood discovery depends on the Computer Browser service 
that maintains an updated list of computers on the network. If the Computer Browser 
service is stopped or disabled, Windows network neighborhood discovery will not work 
properly. To resolve computer names to IP addresses the Windows Internet Naming 
Services (WINS) must be installed and configured.

Use the context menu or the buttons to 

● Enable or disable Windows network neighborhood objects

● Add new Windows network neighborhood objects

● Browse existing Windows network neighborhood objects

● Remove Windows network neighborhood objects 

● Import new Windows network neighborhood objects from file

● Configure administrative credentials for Windows network neighborhood objects

Click Update to display Windows network neighborhood objects available on the 
computer running JDisc Discovery.
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Figure: Network Neighborhood Tab

Enter administrative credentials for selected Windows network 
neighborhood objects to improve discovery results. 

The Windows Internet Naming Services (WINS) must be installed 
and configured for the Windows network neighborhood discovery to 
function properly. 

5.2.1.6 Directory

The Directory tab displays the directories hierarchy. The directories hierarchy serves 
two purposes:

● Associate directory objects to a group

● Configure login credentials with directory objects. JDisc Discovery's discovery 
uses these login credentials to access computers that are member of a directory 

To enable directory discovery:

● Select a group

● Select directory objects, open the context menu and choose any of the flowing 
options:

Discover all computers of the selected directory object.
This requires only access to one Global Catalog (GC) server/service.

Discover all computers of the selected directory object and all sub-directory 
objects.

Discover recently logged-on computers of the selected directory object.

This requires access to DNS Domain Controllers (DC) of the respective DNS 
domain. To cover all logged-on computers, make sure all DNS Domain 
Controllers (DC) are configured (either manually or automatically 
discovered).
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Discover recently logged-on computers of the selected directory object and 
all sub-directories.

You can also use the Toggle or the Space key to toggle between these discovery 
modes 

Discover all computers of the selected directory object.

This requires only access to one Global Catalog (GC) server/service. 

Discover all computers of the selected directory object and all sub-directory 
objects.

Discover recently logged-on computers of the selected directory object.

This requires access to DNS Domain Controllers (DC) of the respective DNS 
domain. To cover all logged-on computers, make sure all DNS Domain 
Controllers (DC) are configured (either manually or automatically 
discovered).

Discover recently logged-on computers of the selected directory object and 
all sub-directories.

Click Change Account to configure administrative login credentials for selected 
directory objects. Directory object's having login credentials display the user name in 
brackets next to the directory object's name.

Figure: Directory Object with Login Credentials

5.2.1.7 SNMP

The SNMP tab displays default SNMP communities and SNMP accounts for the 
selected group. The SNMP tab is divided into the SNMPv1/v2c communities and 
SNMPv3 accounts panels.

JDisc Discovery uses SNMP protocols and default SNMP communities/accounts in this 
order when accessing a device:

1. SNMPv3 accounts in the order as they appear in the SNMPv3 accounts panel

2. SNMPv1/v2c communities in the order as they appear in the SNMPv1/v2c 
communities panel

When an SNMPv3 account or SNMP v1/v2 community succeed, JDisc Discovery 
associates and stores the account or community with the device. JDisc Discovery will 
not try default SNMP accounts or communities in subsequent discoveries but uses the 
associated SNMP account or community. Only if these fail, default SNMP accounts and 
communities will be tried again.
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Figure: Default SNMPv1/v2c Communities and SNMPv3 Accounts

Use Add to add new SNMP v1/v2 communities and SNMPv4 accounts in the respective 
panel. Click Remove to delete communities and accounts. Use Move Up and Move 
Down to change the order of communities and accounts.

5.2.1.8 Accounts

The Accounts tab displays default login credentials for computers running Windows, 
Unix and MAC OS X. Depending on the protocol configuration (remote login with telnet, 
or SSH) you might need to configure default SSH login credentials based on 
public/private keys.
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Figure: Default Accounts

This dialog might vary depending on the licensed edition.

Use the list of Windows default accounts only if the configuration 
via network neighborhood or organizational units from the directory 
do not succeed.

Click Add to add new login credentials including public/private keys. Specify if the login 
credentials hold root or ordinary user privileges. If in doubt, choose user. JDisc 
Discovery Checks – if needed - if login credentials hold root privileges during the 
discovery process.

Figure: Add new Default Account
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Use Add in the public/private key panel to add new login credentials for SSH.

Import SSH public/private keys for use as default credentials in the 
Public/Private Keys panel. Refer to section 5.9 for more information 
on how to import SSH keys.

Figure: Add new public/private Key Account

5.2.2 Root Group

The root group (named 'Company') is created by JDisc Discovery's installation program 
and contains all IPv4, IPv6 networks, all IPv4 ranges, all Windows network 
neighborhood objects and all directory objects. You cannot delete the root group but 
you might change its name from the root group's property tab. Networks, address 
ranges, Windows network neighborhood objects and directory objects that have been 
created in subgroups also appear in the root group.

The root group is associated to the 'Discover all' discovery job, which always exists. 
Whenever you select Discovery » Control » Start Discovery and have not created 
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additional discovery jobs, JDisc Discovery starts the 'Discover All' discovery job. This 
way JDisc Discovery discovers all enabled IPv4 networks, IPv4 address ranges, 
Windows network neighborhood objects and directory objects.

5.2.3 Sub Groups

Create new subgroups as described in the grouping section 3.3. Depending on the sub 
group type, JDisc Discovery displays different tabs:

● Network groups include the Properties, Networks, Ranges, SNMP and the 
Accounts tabs.

● Windows network neighborhood groups include Properties and the Network 
Neighborhood tabs.

● Directory groups include Properties and the Directories tabs.

5.3 Directory Tab

The Directory tab displays directories (by DNS domain) and DNS domain controllers for 
each directory. JDisc Discovery automatically detects directories and associated DNS 
domain controllers using the Server Message Block (SMB) protocol. Directories can 
also be added indirectly by adding and configuring a DNS domain controller and login 
credentials.

5.3.1 Configure Directory DNS Domain Controller 

To synchronize directory information and networks, a directory must be configured 
having at least one DNS Domain Controller and login credentials to run Lightweight 
Directory Access Protocol (LDAP) queries. To configure a DNS Domain Controller and 
login credentials:

● Open the Discovery Configuration dialog from Discovery » Configuration.

● From the Discovery Configuration dialog, choose the Directory tab and select a 
directory by DNS Domain from the DNS Domains panel.

● If the DNS Domain Controller panel is empty, click Add to add a DNS Domain 
Controller and login credentials for the selected DNS Domain.

If the local computer running JDisc Discovery is a member of a directory, 
the Add DNS Domain Controller dialog always defaults to a DNS Domain 
Controller for this directory. 

If you have selected a directory different from the local computer's directory, 
override the DNS Domain Controller as appropriate.
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● If the DNS Domain Controller panel contains at least one host name, click 
Change to open the Directory Service Account dialog and enter login credentials 
for the directory's DNS Domain Controllers.

● Finally click Test to test the connection to all configured DNS Domain Controllers 
for the directory.

5.4 Data Collection

The data collection tab specifies what details to discover from devices, defines custom 
scripts used for software data collection and defines a set of simplified file collections 
for various devices.

5.4.1 Standard Data Collection

The Data Collection tab allows choosing what details to discover from devices on the 
network. 
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Figure: Data Collection Tab

5.4.1.1 Users

JDisc Discovery's user discovery distinguishes

● Local users that exist locally on a computer

● Logged on users that have been logged on to a computer at the time of the 
discovery

JDisc Discovery stores users that have been logged on to a computer for a 
configurable period. Use the 'Delete users from logged on user history when not logged 
on for <n> days' option to automatically delete users from the logged on user history 
when they have not logged on for the designated number of days.

Change the selection for ignored users to suppress built-in and service users.

Terminal services client sessions (either Windows RDP or Citrix ICA) can be detected 
when the 'Find terminal services clients' option is enabled and Windows remote login is 
also enabled. Moreover, JDisc Discovery also detects  client computers from which 
terminal services session has been established. Enable the 'Discover terminal services 
clients' option to automatically discover terminal services client computers.

Terminal services client detection requires the Windows remote login 
protocol. 

When discovering locally attached devices such as USB printers, 
scanners or card readers, JDisc Discovery takes the device type filters 
into account. So JDisc Discovery will not discover local printers, when 
printers are disabled within the type filters even if the discovery for local 
printers is enabled. 

  

5.4.1.2 Software/Hardware

Enable or disable any of the items below as appropriate:

● Applications / license keys

● Patches

● Services7

● Drivers

● Processors

● Memory modules

● Video controller8

● Clusters (Microsoft, HP, and Veritas clusters)

7 For Windows and Solaris
8 For Windows and Linux
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● Physical, logical disks and disk partitions

● Attached devices (for example printers attached to print servers or monitors 
attached to a computer9)

● Blade enclosure components (for example blade servers or blade switches)

● Managed devices (such as servers managed by a server management 
processor)

Disable data collection items that you do not need. This saves 
database disk space, reduces network traffic and speeds up 
discovery jobs.

5.4.2 Virtualization Data Collection

Use the Virtualization tab to configure the details for scanning virtual environments.

Configure whether to scan offline instances, VMware annotations and virtual machine 
motion events.

Figure: Virtualization Data Collection

9 Monitor discovery is supported only on Windows
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5.4.3 Exchange Server

JDisc Discovery can collect detailed information for Microsoft Exchange server. It runs 
Powershell scripts on the target computer in order to retrieve the list of exchange 
mailboxes with their sizes.

Figure: Exchange Server Discovery Configuration

5.4.4 Database Discovery

JDisc Discovery can collect detailed information for several databases. Use the 
Database tab in order to configure the collectibles for databases.
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Figure: Database Discovery Settings

5.4.5 Custom Data Collection

The Custom tab allows configuring the custom data collection. 
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Figure: Custom Data Collection Configuration

5.4.6 File Collection

JDisc Discovery can collect configuration files or command outputs from system 
commands from various operating systems. When the network add-on is installed, 
JDisc Discovery even collects configuration files from various routers and switches.
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Figure: File Collections

Select an operating system platform and click Add to add new file collection. Refer to 
chapter 11 for more details on the file collection mechanism.

5.5 Discovery Jobs

Discovery jobs provide a means to partition the discovery of large enterprise networks. 
Refer to chapter 3.4 for a detailed description of scheduled discovery jobs.
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Figure: Discovery Jobs Tab

The 'Discover all' discovery job is created by JDisc Discovery's installation program and 
is permanently associated to the root group. You cannot change the group assignment 
or delete this discovery job. However, you might change the directory synchronization 
options or and define a schedule.

Create new discovery jobs by using the context menu in the left panel.

● Enter a name and description in the New Discovery Job dialog and click Ok.

● Select the new discovery job and adjust the discovery settings as needed.

- 154 -



Figure: Create new Discovery Job

Change a discovery job's settings in any of theses tabs:

● Change the discovery job name and description in the Properties tab.

● Use the Groups tab to associate groups to the discovery job. Groups define the 
discovery scope in terms of IP networks, IP ranges, Windows network 
neighborhood objects and directory objects. 

● Choose directory synchronization options in the Directory tab. 

● Schedule the discovery job from the Schedule tab

5.5.1 Properties

The properties displays the discovery job name and a description.

Figure: Properties Tab

5.5.2 Groups

Groups define the scope of a discovery job. Discovery jobs can be associated to one or 
more groups. 
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The built-in discovery job 'Discover all' cannot be altered and 
therefore the Groups tab is disabled. 

In the group tree, choose any of the options below: 

● Enable to explicitly associate the selected group only.

● Enable Subgroup to associate the selected group including its subgroups. 

● Reset to remove the association of the selected group and its subgroups.

Figure: The Groups Tab

The check mark next to the group name indicates if a group is associated to a 
discovery job. 

● Groups with black check marks  are explicitly enabled. 

● Groups with a gray check mark  are implicitly enabled through one of their 
parent groups. 

● Groups without check mark are disabled.
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5.5.3 Directory

The Directory tab provides directory and networks synchronization options. When 
enabled, JDisc Discovery will synchronize directory objects and IPv4 networks from all 
(configured) directories when the discovery job is started.

Synchronizing IPv4 networks can also provide location information for each network 
when the directory administrator maintains network location information in the directory. 

Figure: Directory Synchronization Options

5.5.4 Schedule

Every discovery job can be individually scheduled and runs independently from other 
(scheduled) discovery jobs. By default, discovery jobs are created set to Not 
scheduled. Not scheduled discovery jobs can be started manually from Discovery » 
Control » Start Discovery.

JDisc Discovery can run discovery jobs using any of the schedule types below:

● Run Once 

● Daily

● Weekly
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● Monthly

● Recurring

5.5.4.1 Run Once

Choose Run Once to run a discovery job only once at the specified date and time.

Figure: Run Discovery once

5.5.4.2 Daily

Choose Daily to run the discovery every day at the specified time. When a discovery 
runs longer than a full day the discovery job starts the next day at the specified time.

Fig: Run discovery daily

5.5.4.3 Weekly

Choose Weekly to run a discovery job once every week. Specify the day and time when 
to start the discovery job.

Figure: Run Discovery weekly
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5.5.4.4 Monthly

Choose Monthly to run a discovery job every month. Specify the day of the month and 
time when to start the discovery job.

Figure: Run Discovery monthly

5.5.4.5 Recurring

Choose Recurring to run a discovery job periodically. In addition to specifying the 
interval, you can also set the date and time when to run the discovery job for the first 
time.

Fig: Run recurring discovery

5.6 Protocols

The Protocols tab displays all available protocols employed by JDisc Discovery's 
discovery. You can enable and disable any protocol except of ICMP ping. 

Change the timeout values as appropriate. Higher timeout values generally improve 
protocol detection but might also slow down the discovery process. 

Disabling important protocols, such as SNMP or WMI might degrade the discovery 
result.
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Disabled protocols and too low timeout values might affect the quality of 
the discovery result.

Figure: Protocols Tab

This dialog might vary depending on the licensed edition.

JDisc Discovery's installation program configures defaults timeout values that should fit 
most corporate networks. If needed, you might change timeout values if these do not 
accommodate to your network and systems.

5.6.1 Windows Computers

JDisc Discovery's Windows remote login agent is a Windows service that is  
temporarily deployed to target Windows computers from the  JDisc Discovery server. 
The JDisc Discovery server communicates with the agent using a Windows named pipe 
which is restricted to members of the local administrators of the computers running the 
agent. Furthermore all named pipe communication is compressed and securely 
encrypted. 
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The remote login agent automatically uninstalls after a configurable idle period when it 
has not been accessed by a JDisc Discovery server. When you periodically re-discover 
your network, set the idle period to a value longer than the discovery schedule so that 
the agent is still running when  JDisc Discovery discovers it the next time. This way you 
can increase the discovery speed and reduce network traffic.

5.6.1.1 WMI And Remote Registry Protocol Tunneling

When firewalls block WMI or remote registry traffic, JDisc Discovery's WMI and remote 
registry tunneling feature can improve the discovery result. When tunneling is enabled, 
JDisc Discovery tunnels WMI and registry requests through its remote login agent. 
Native access refers to accessing a protocol without using the remote login tunnel. 

JDisc Discovery offers these WMI and remote registry protocol tunneling options:

1. Disabled:
JDisc Discovery does not use any tunneling.

2. Use always:
The tunnel is always used no matter if native access succeeds or fails.

3. Use tunnel when native access fails:
JDisc Discovery uses the tunnel only, if native access fails (e.g. when WMI is 
blocked by a firewall).

4. Use native access when tunnel fails:
JDisc Discovery prefers using the tunnel and uses native access only when the 
tunnel fails.

Make sure to configure tunneling WMI and remote registry 
protocols via remote login when remote login for Windows is 
enabled!

5.6.2 Unix And Mac OS X Computers

Remote login is needed to properly discover Unix and Mac OS X computers. Refer to 
section 4.3 for more information on how to discover Unix computers. 

Configure remote login for Unix and Mac OS X platforms in the Remote Login panel. 
JDisc Discovery can log-in using:

● Secure Shell (SSH)

● Telnet

Remote login provides these options: 

● Remote login disabled

● Use telnet only

● Use SSH and then telnet

● Use SSH only
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SSH logins in conjunction with too many default credentials can 
cause intrusion detection systems to raise alerts!

In few cases JDisc Discovery requires root access - for instance when reading BIOS 
information on Linux computers. Whenever possible, JDisc Discovery tries to avoid 
using root/administrative privileges. When root/administrator access is needed, JDisc 
Discovery offers three methods to execute commands with root/administrator 
privileges:

● Call the 'su' command to switch to the root user.

● Call 'sudo' to execute commands with root access.

● Call '.do' to execute commands with root access.

Specify the Connect timeout for establishing a connection and the Execute timeout for 
executing system commands. JDisc Discovery sends CTRL-C to abort command 
execution when running longer than the configured timeout value permits.

Configuring remote login for Unknown platforms is important for security-hardened 
systems. For instance, many Linux distribution disable telnet and SNMP per default. In 
such cases, JDisc Discovery cannot determine the operating system using agent-less 
protocols. 

When remote login for Unknown devices is enabled and login credentials are 
configured (either individually assigned to the device or default credentials), JDisc 
Discovery logs to the system using telnet or SSH and executes the 'uname' command. 
JDisc Discovery parses the 'uname' command output to determine the operating 
system and finally utilizes the platform's login method to identify the device and to 
collect inventory information.

Enable remote login for Unknown devices to identify the operating 
system version of security-hardened systems.

5.6.3 Windows Computers

Windows remote login is an alternate method to discover device details on computers 
running: 

● Windows NT 4.0 that do not have Windows Management Instrumentation (WMI) 
or proprietary vendor specific SNMP agent extensions installed. 

● Windows NT 4.0 and better that have personal firewalls installed or firewalls on 
the network blocking DCOM/DCE RPC traffic. 

Windows remote login requires administrative login credentials to push JDisc 
Discovery's zero-footprint remote execution agent on Windows computers that runs as 
a service and uses a named pipe (encrypted data transmission) to communicate with 
the JDisc Discovery server. JDisc Discovery's zero-footprint remote execution agent 
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offers SSH like functionally, such as command execution, command output capture and 
file transfer. JDisc Discovery's zero-footprint remote execution agent automatically 
deletes itself 60 seconds after being accessed last by a JDisc Discovery server. 

5.7 Filters

JDisc Discovery can filter devices based on several device attributes and by IP address 
exclusion ranges. The discovery process only discovers and stores devices in the 
database that pass the filter criteria.

JDisc Discovery allows to create multiple filter configurations which are optionally being 
applied to only a part of the network (e.g. specific IP ranges or devices belonging to 
groups). Each filter configuration can be enabled or disabled separatley.

There are two basic filter types:

● IP exclusion filters
exclude single IP addresses or IP ranges with IP exclusion filters.

● Attribute based filters
exclude devices based on attributes such as model, manufacturer, type, os 
version.

Attribute filters can be restricted to specific IP ranges or device groups. Note that 
attribute based filters require the discovery of at least the identifying attributes such as 
model, type, or manufacturer.

There is a pre-defined IP exclusion filter called 'Built-in IP Filter'. This filter is being used 
for devices which are permanently excluded when deleted. The pre-defined filter cannot 
be removed.

Figure: Filter Tab

Use the Info button to display the filter definition.
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There are two different filter types: IP exclusion filters and filters 
based on device attributes. There can be multiple filter 
configurations which can be enabled invidually.

5.7.1 IP Exclusion Filter

Create a new IP exclusion filter by clicking he Add button. Choose 'IP Filter' as filter 
type. The Wizard guides you through the filter definition which includes a name and 
description and on the second panel the list of IP filters.

Figure: Choose the Filter Type

IP Filters exclude devices by IP address ranges or single IP 
addresses. configurations which can be enabled invidually.

You might see multi-homed devices in reports having IP addresses 
within excluded IP addresses ranges. However this does not mean 
JDisc Discovery has accessed the IP address within the exclusion 
range!

5.7.2 Attribute Based Filters

Attribute based filters filter devices by matching device attributes such as model, 
manufacturer, type or operating system version. Click the Add button and select 
'Attribute Filter' in order to create a new attribute based filter.
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Figure: Create a new attribute based filter

A wizard guides you through the three steps of the filter configuration:

● define the filter name and optionally provide a description

● define the scope for the filter (either global, IP range, or device group)

● define the filter criterias for selected fields

The filter name and the description helps to identify filters.

Figure: Define filter name and description

The next step defines the scope for the filter. Choose between

● the global scope (apply the filter to all IP ranges)

● the IP range based scope (apply the filter to devices which have an IP address 
that belongs to a specific IP range)

● the device group based scope (apply the filter to devices which have an IP 
address that belongs to the network list for a defined device group)
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Figure: Define the Filter Scope

Use the filter scope to limit the filter to specific network areas.

Define the filter criteria in the last step. Define filter criteria for at least one field. When 
using filter criterias for multiple fields, then the device gets only filtered, if it matches the 
criterias for all fields.

Figure: Define Filter Criteria

Click Finish to complete the filter defintion.

Using attribute based filters speeds up the discovery, lowers the 
network bandwidth usage and reduces the database size by 
ignoring devices which are not relevant for your inventory
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JDisc Discovery creates discovery events when a device does not pass the attribute 
filter. This helps to troubleshoot filter issues.

Figure: Attribute Filter Events

5.7.3 Filter Information

Filter definitions can become complex. Use the Info button in order to display a filter 
definition overview.

- 167 -



Figure: Filter Configuration Summary

5.8 Cloud

Configure Microsoft Azure cloud access within JDisc Discovery once you have 
completed the preparation steps from the previous chapter. You will need:

● The so called tenant id. The tenant id might also be called directory id

● The application id

● The key secret

You can get the tenant id from the Azure portal within the Active Directory/Properties 
tab. The application id and the key secret is available from the your steps when you 
registered the application.

Enter the Azure cloud information in the configuration dialog.
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Figure: Add access credentials for an Azure cloud directory

You might enter access credentials to more than one Azure cloud 
directory!

5.9 SSH Keys

JDisc Discovery supports using SSH (Secure Shell) public/private keys for login 
authentication. To use existing SSH keys for authentication on SSH enabled devices, 
import your SSH keys into JDisc Discovery's configuration.
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Figure: Private Keys

Click Import to import existing private SSH keys. Private keys must use the OpenSSH 
format!

Private SSH keys are stored safely in JDisc Discovery's database. 
Refer to the 'Security' chapter of the 'Administration and Security 
Guide' for information on how JDisc Discovery stores login 
credentials.

Private SSH keys must use the OpenSSH format!
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6 Reporting

JDisc Discovery's reporting system provides a variety of built-in reports. Most reports 
display tabular data. 

Tabular reports have a: 

● Toolbar

● Filter field (including a case sensitive check box)

● Table header

● Content area

● Footer line 

Figure: A typical JDisc Discovery Device Report

Use the filter filed to only display lines that contain the filter value. The report filters its 
content as you type.

The tool bar provides these following icons:

Display the context menu
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Return to the previous report

Go to the next report

Reload the current report

Open a new Window with the same report

Create an Microsoft Excel export for the current report

Create a CSV plain text export for the current report

Schedule automatic report exports

Show the SQL query that created the current report

Open the grouping tree view to restrict the report on groups

Table headers are in most cases sortable. Click on a header column to change the 
table's sort order.

The table footer displays the table's total number of lines, the number of selected, and 
filtered lines.

Use the right mouse button to open the context menu for the report. The context menu 
items depend on the actual report.
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Figure: Report Context Menu

Use copy-paste to copy report content to the clipboard.

6.1 Built-in Reports

JDisc Discovery offers a variety of predefined reports for all discoverable objects and 
diagnostic information. 

6.1.1 Devices

The Devices menu contains device oriented reports. Devices can be grouped by 

● Model

● Type

● Manufacturer

● Operating system family and version

● Device roles and groups.

Double click a device to display device details.

6.1.1.1 Directory Membership

The 'Explorer-like' Computer Accounts (Devices » Directory menu item) report displays 

• Active Directory instances (including the directory hierarchy) in the left  
navigation panel

• Directory member computers / accounts on the right side 

When you select the Include computer accounts from sub directories option, all 
computer accounts of the selected directory object and sub directory objects will be 
displayed. 

Figure: Directory Computer Accounts 

Note: The two numbers in parentheses next to the directory object 
name indicate 

• number of computer accounts that exist in the directory

• number of computers / devices that have been discovered 
and matched against existing computer accounts.
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When the parentheses contain only a single number the directory 
object and none of its sub directory objects have been discovered. 
However a computer / device that is member of the directory 
objects or any of its sub directory objects has been discovered and 
assigned to the directory. 

6.1.2 Virtualization

The Virtualization menu item contains virtualization related reports including host 
servers and virtual instances.

6.1.3 Software

The Software menu contains application, application instances, patch, and services 
reports that span across all devices.

6.1.4 Networking

The Networking menu contains network oriented reports including 

● IPv4 networks

● IPv4 address ranges

● IPv6 networks

● Windows network neighborhood (Windows domains and workgroups)

● Directories (Microsoft Active Directory)

6.1.5 User

The User menu item provides user, user group (including group membership) and login 
credentials (including SSH keys) reports.

6.1.5.1 Login Credentials

The All Login Credentials report shows all occurrences of login credentials for devices 
and Windows Domain Controller (DC) or Global Catalog (GC) servers.

Figure: All Login Credentials

The All Login Credentials report has got several columns as described below:
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• Login is the login (user / account) name.

• Password Count contains the number of different passwords of the Login.

• Configuring more than one password for a global login can result in user 
lockout. This can happen when the discovery process repeatedly uses 
incorrect passwords to establish a connection to a  device.

If a global login is assigned more than one password, select the Login in 
the report and use the "Change password..." context menu to set the 
correct password for all occurrences of the global login.

• Device Count is the number of devices for which the Login is configured. 

• Network Neighborhood shows the Windows domains / Workgroups for which the 
Login is configured. 

• DNS Domain displays the Active Directory forests for which the Login is 
configured.  

• Login is used only to connect to Domain Controllers (DC) or Global 
Catalog (GC) servers and performing read-only LDAP/S queries.

• The Directory Object column shows the Active Directory objects (DNS Domain, 
Organizational Unit or Container) for which the Login is configured.

• The discovery process uses the Directory Object Login to connect to the 
directory's member computers. 

• The Default Account Device Platform states for what operating system platform 
(I.e. Windows, Linux, etc.) the Login has been configured. 
 

You can use the All Login Credentials report for a selected Login to

• Change a Login password  

• Change a Login & password

• Delete a Login

When you change the password or Login name, or when you delete a Login, all 
occurrences of the Login in the database are updated. 

Change a Login Password...
To change a Login's password, select the Login in the All Login Credentials report and 
click Change password... from the context menu.  
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Figure: Modify Password

If you want to set a New password for all occurrences of the selected Login,  leave the 
Old password field empty. 

You can also set a New password only for occurrences of the selected Login that have 
been assigned the Old password. In this case simply enter the Login's Old password. 

Change Login and Password...
To change a Login and password, select the Login in the All Login Credentials report 
and click Change login and password... from the context menu.

Figure: Modify Login & Password

This works similarly to Change a Login's Password from above. However, you can also 
change the login name for all occurrences of Login.

Delete a Login
To delete a Login, select the Login in the All Login Credentials report and click Delete... 
from the context menu.

Figure: Delete Logins

You can either delete All occurrences of the selected Login or only those occurrences 
where the password matches. If you chose By Password, enter the password in the 
Delete Login dialog.
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Figure: Delete Login

6.1.6 Troubleshooting

The Troubleshooting menu item contains troubleshooting and diagnostic reports that 
help finding common discovery problems discovery and permit modifying the discovery 
queues.

Most reports provide a context menu for management and discovery 
tasks or to simply display detailed information. Open the context menu 
with the right mouse button.

6.2 Common Actions

JDisc Discovery's reports provide context menus to perform frequently used actions.

6.2.1 Run Immediate Discovery

JDisc Discovery can run an immediate discovery of devices, IPv4 networks, IPv4 
address ranges and directory objects. The table below illustrates the discover menus in 
the respective reports.

Report Discovery menu
Device reports Click Discover » Selected Devices to discover 

selected devices. JDisc Discovery will perform a DNS 
lookup to find IP addresses of selected devices. This is 
useful for devices using DHCP or that change their IP 
address frequently.

Click Discover » Selected IP Addresses to discover 
selected devices via their IP addresses. This is not 
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recommended for devices and networks using DHCP, 
because the IP address might have changed.

IPv4 network 
report

Click Discover » Selected Network(s) to discover 
selected IPv4 networks.

IPv4 address 
range report

Click Discover » Selected Range(s) to discover 
selected IPv4 ranges.

Windows 
Network 
Neighborhood 
report

Click Discover » Windows Network Neighborhood to 
discover selected Windows domains and workgroups.

Directory report Click Discover Directory to discover selected directory 
objects.

Figure: Discover selected Devices

6.2.2 Manage Devices

Device reports allow changing a device's login credentials including SSH public/private 
keys. Select a single or multiple device and open the context menu. The Manage menu 
offers these sub menu items:
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● Click Change Accounts to configure login credentials.

● Click Change SSH public/private Key to configure SSH keys.

● Click Change SNMP credentials to configure SNMP communities and accounts.

● Click Synchronize Group Assignment to manually reassign devices to groups 
based on information in the database. This is useful when group conditions have 
changed and you want to prevent running a discovery job, which would 
automatically assign devices to groups.

 

Figure: Manage Devices

6.2.3 Compare Devices

Select the Compare menu item to compare two devices with each other.

6.2.4 Connect To Device

Open the context menu and choose Connect with to connect to a device. JDisc 
Discovery can connect to a device using:

● Telnet
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● SSH

● Microsoft Terminal Services

● HTTP

● HTTPS

When connecting to a device JDisc Discovery does not pull login credentials from the 
database for security reasons. You will be prompted to specify login credentials 
manually.

Figure: Connect to a Device
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6.2.5 Troubleshooting

Click Perform SNMP Walk from the Troubleshooting menu to dump all SNMP variables 
of a SNMP enabled device. 

Figure: SNMP Walk

Click Ping to ping IP addresses of selected devices. Enter the timeout and retry 
parameters and press Ok. JDisc Discovery will ping all active IPv4 and IPv6 IP 
addresses and display the results.

ClickBrowse WBEM/WMI Data in order to review WBEM or WMI information for the 
selected device.

Click Traceroute in order to view the traceroute output for the selected device.

6.2.6 Delete Devices

JDisc Discovery does not automatically delete devices from the database that have 
been disconnected from the network or which do no longer exist. Click Delete Devices 
to delete selected devices from the database.
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6.2.7 Create Support ZIP

JDisc Discovery can pack the information required by our support  to help 
troubleshooting discovery problems. To create a support ZIP file, select a set of devices 
and click Create Support ZIP  to create a support ZIP file.

6.3 The Device Details Report

The Device Details report displays detailed device information. Double click a device or 
choose Properties from the device's context menu to open the Device Details report.

JDisc Discovery does not always collect all device details. Data 
quality greatly depends on the device type, platform, available 
protocols and the network infrastructure (firewalls).

The Device Details report consists of the nine tabs:

● The General tab displays basic device information such as name, manufacturer, 
model, type, serial number, etc.

● The Networking tab displays network interfaces, IPv4 networks to which the 
device is connected and the SNMP system group variables.

● The Hardware tab displays processors, memory modules, physical/logical disk 
information and attached devices.

● The Firmware tab displays firmware version, manufacturer and the SMBIOS 
version for Intel based systems.

● The Software tab displays operating system information, installed application 
and patches.

● The User tab displays local user, logged on user and logged on user history.

● The Virtual Computers tab displays virtual (computer) instances running on the 
selected device.

● The Roles tab displays device roles assigned by the discovery.

● The Groups tab displays all groups to which the device belongs.

● The Analyze tab displays the discovery log, protocol status, parsing issues, and 
rule based diagnostics.

6.3.1 General Tab

The General tab displays the following device information:

● Name
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● Manufacturer

● Model

● Type

● Serial number

● Hardware version

● Part number

● Windows computer name

● Windows network neighborhood name (if member of a Windows domain or 
Workgroup)

● Directory object name (if member of a directory)

● Creation date (first discovery date)

● Last discovery date

● Discovery duration (Device identification and device data collection)

● Database duration (Database update transaction)

● If the device is a virtual (computer) instance, JDisc Discovery can display the 
physical host server on which the virtual (computer) instance runs.

Figure: Device Details » General Tab
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6.3.2 Networking Tab

The Networking tab displays network interfaces, IPv4 networks to which the device 
belongs and SNMP system group variables.

6.3.2.1 Interfaces

The interfaces table displays all interfaces including interface type, description, speed, 
assigned DNS names, IP addresses and subnet masks.

Figure: Interfaces Table

6.3.2.2 Networks Tab

The Networks tab displays IPv4 networks to which the device belongs. To display all 
devices in the networks displayed, select a network and open the context menu and 
choose a report.
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Figure: Networks Table

6.3.2.3 SNMP System Group

If a device supports SNMP, the SNMP system group displays standard SNMP variables 
such as System Object ID, System Description, etc.
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Figure: SNMP System Group Tab

6.3.3 Hardware

The Hardware tab displays processors, memory modules, disks and attached devices.

6.3.3.1 Processors

The Processors tab displays physical processors. Dual core and hyper-threaded 
processors appear as one row. The core count and the thread count columns describe 
a physical processor in more detail.
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Figure: Processors Tab

6.3.3.2 Memory Modules

The Memory Modules tab displays memory modules including size, model, and 
manufacturer. When JDisc Discovery cannot discover memory modules the total 
memory size will be displays instead. In this case the memory module slot is named 
'Total'.

- 187 -



Figure: Memory Modules Tab

6.3.3.3 Disks

The Disks tab is separated into these tabs Physical Disks, Disk Partitions, and Logical 
Disks.

Physical Disks
The Physical Disks tab displays all physical disks including model, manufacturer, serial 
number and total size.
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Figure: Physical Disks Tab

The Total Physical Disk Space displays the sum of all physical disks.

Disk Partitions

The Disk Partitions tab displays all partitions on the computer.
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Figure: Disk Partitions Tab

Logical Disks
The Logical Disks tab displays mounted logical disks on the computer. Logical disks 
have these attributes: 

● Name

● Mount point

● Total size

● Used size

● Free size

● Serial number
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Figure: Logical Disks Tab

The Total disk space, Total used space, and Total free space fields list the accumulated 
number for all logical drives.

Attached Disk Arrays
JDisc Discovery discovers attached disk arrays for HP-UX computers.

6.3.3.4 Video Controller

The Video Controller tab displays a computer's video controllers.
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Figure: Video Controllers

6.3.3.5 Attached Devices

The Attached Devices tab displays directly attached devices. JDisc Discovery discovers 

● printers attached to print servers

● tape drives attached to tape libraries

● monitors attached to a computer

● blade workstations, servers, switches and power supplies mounted in a blade 
enclosure

● rack or blade servers connected to a management device
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Fig: Attached monitor

6.3.4 Firmware

The Firmware tab displays firmware version information. Firmware includes 

● Name (BIOS manufacturer name for Intel/AMD based systems)

● Manufacturer

● Version (BIOS version for Intel/AMD based systems) 

● Release Data

● SMBIOS Version
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Figure: Firmware Tab

6.3.5 Software

The Software tab displays operating system, applications, application instances, 
patches and services.

6.3.5.1 Operating System

The Operating System tab displays 

● OS Family - classification of operating systems into families, such as Windows, 
HP-UX, etc 

● OS Version - operating system name including version information

● OS System Type – the system type (such as x86, x64, ia64 and Sparc)

● Patch Level - Service Pack on Windows platforms

● Install Date

● System Uptime

● Owner

● Unique Id 

● Product Key

● Locale - language locale on Windows platforms
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Figure: Operating System Information

6.3.5.2 Applications

The Applications tab displays installed applications.
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Figure: Applications Tab

6.3.5.3 Application Instances

The Application Instances tab displays installed application instances such as database 
instances, JEE application server instances or web server instances.
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Figure: Application Instances

6.3.5.4 Patches

The Patches tab displays installed patches.

- 197 -



Figure: Patches Tab

6.3.5.5 Services

The Services tab displays installed services including important service attributes.

Figure: Installed Services

6.3.5.6 Drivers

The Drivers tab displays installed drivers including important driver attributes.
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Figure: Installed Drivers

6.3.5.7 Executables

The Executables tab displays the list of all executables found on local harddrives.
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Figure: The list of all local executables

6.3.5.8 Processes

The Processes tab displays running processes including important process attributes.

Figure: Running Processes

6.3.5.9 Cluster

The Clusters  tab lists all cluster services running on a member of a cluster. 
Additionally, it lists the cluster name that the device belongs to.

6.3.6 User

The User tab is divided into three sub-tabs.

6.3.6.1 Logged On Users

Displays users that have been logged on when the device has been discovered.
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Figure: Logged on Users

6.3.6.2 Local Users

Displays local users.
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Figure: Local Users

6.3.6.3 Logged On User History

Displays users that have been logged within a configurable number of days.
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Figure: Logged on User History

6.3.6.4 User Profiles

The User Profiles report lists all users who have previously logged on to a computer. It 
does not matter whether the users were actively logged on at the time of the scan, 
unlike in the Logged-on Users or User History reports.

Figure: User Profiles

6.3.7 Virtual Computers

The Virtual Computers tab displays virtual computers (for example VMware) running on 
a host server.
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Fig: Virtual Computers tab

6.3.8 Custom Attributes

The Custom Attributes tab displays the custom attribute hierarchy including the 
attributes for the selected folder.
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Figure: Custom Attributes Tab

6.3.9 Roles

JDisc Discovery assigns roles (for example 'database server', 'domain controller', etc.) 
to device during discovery. The Roles tab displays roles assigned to a device.
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Fig: Roles tab

6.3.10 Groups

During the discovery process, JDisc Discovery assigns devices to groups (Refer to the 
Grouping chapter 3.3 for more details. The Groups tab displays groups to which a 
device it assigned.
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Figure: Groups Tab

6.3.11 Analyze

The Analyze tab consists of four sub-tabs that focus on troubleshooting and diagnosing 
the discovery. 

● Discovery Log 

● Protocols

● Parsing Issues

● Diagnostics

6.3.11.1 Discovery Log

The Discovery Log tab displays the sequence of activity during discovery of a device 
including errors and warnings when encountering unexpected results. The Discover 
Log is the most important tool to troubleshoot discovery problems.

- 207 -



Figure: Discovery Log Tab

6.3.11.2 Protocols

The Protocols tab displays all protocols including the protocol status. The protocol 
status can help finding discovery problems, such as firewalls, incorrect credentials, etc.
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Figure: Protocols Tab

6.3.11.3 Parsing Issues

To retrieve hardware, software and configuration information, JDisc Discovery executes 
system commands on Unix and MAC OS X computers, parses the command output 
and stores the information in the database. 

The output format of system commands often depends on the operating system 
version. Though JDisc Discovery detects many system commands outputs on 
supported platforms, operating system updates can change the system command 
output formats unexpectedly. In such a case, JDisc Discovery might fail to parse the 
command output. Therefore JDisc Discovery stores system command output in the 
database, when parsing fails. The system command output is then visible in the 
Parsing Issues tab and helps JDisc Discovery's support to integrate the new format in 
future product versions.
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Figure: Parsing Issues Tab

6.3.11.4 Diagnostics

JDisc Discovery features a rule based expert system to help troubleshooting discovery 
problems. Built-in rules (based on experience) help identifying and resolving discovery 
problems quickly.

Choose the Diagnostics tab to display problems and recommendations for the selected 
device. Double click on an item in the Diagnostics tab to display detailed information. 
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Figure: Diagnostics Tab
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6.4 Virtualization Explorer

Use the JDisc Discovery virtualization explorer in order to browse your virtual 
environments. The virtualization explorer provides a tree with the different virtualization 
technologies together with their topology (including datacenters, cluster, physical hosts 
and virtual machines).

Fig: Virtualization Explorer

The virtualization explorer lists the virtualization technologies within a tree:

● : Management servers for a virtualization technology (for instance vCenter 
installations)

● : Virtual datacenters

● : Cluster

● : Physical server hosting virtual machines

● : VM running as on a physical host

6.5 Send Reports Via EMail

JDisc Discovery allows automatic and scheduled emailing of any report into comma 
separated value or Microsoft Excel formatted files. Often time administrators want to 
share the most recent inventory information with their colleagues from other 
organizations. The simple CSV or Microsoft Excel formats make the inventory 
information directly usable for IT personnel that is not used to run or do not have 
access to JDisc Discovery.

JDisc Discovery can automatically send out any report table as an attachment file to 
desired recipients email addresses. To break down the feature components, the 
following steps show how the feature can be utilized.

6.5.1 Configure The Mail Server

As in regular email services, there must be an email address for the server. In order to 
do that, the sender’s email address properties must be configured. To do so, under 
Administration menu, choose Manage Mail Accounts menu item. 
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Fig: Manage your mail servers and accounts

Clicking on Add buttons takes you to the dialog where you can setup the reports sender 
email address.

Fig: Add a new mail server and account

Once a sender is added to the list, it can be tested using the Test button to make sure 
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that its credentials are correct and a successful connection can be established.

6.5.2 Scheduling A Report

Now that you have a working sender email, you can send any scheduled report. For 
instance, open the report Devices » Virtualization »  Virtual Instances and select the 
clock icon: 

Fig: Schedule a Report Export or Mail Message

From the appeared dialog, select Send report via email option.

Fig: Send Report via EMail

Now a wizard will walk you through four steps in order to configure your scheduling, 
email content, report file properties and report email recipients.

6.5.2.1 Scheduling

Here you decide how often you would like to send your report to the corresponding 
recipients. In the following screenshot you see that it is set to be sent every 2 minutes 
starting from 6 PM, second of February 2016 which is relatively a high frequency of 
sending.
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Fig: Schedule Mail Messages

6.5.2.2 Mail Content

The second page allows you to select the sender’s email address among the list of 
senders that you had setup in the first step (Configuring a sender) and there fields to 
choose the subject and the message content of your email to the recipients.
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Fig: Configure the Mail Message

6.5.2.3 Export Settings

In the third section, the report file must be given a name and you can choose Excel or 
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CSV as the file format. If CSV is chosen as the file format, you can freely choose your 
desired column separator. Other options such as Multiple lines per item and Human 
readable values help you better organize your data format. If the report is empty and 
contains no entry, you are still able to send it by checking the Send empty report 
checkbox. Otherwise, JDisc Discovery discards the mail.

Fig: Configure the Export Settings

Optionally, you might choose a ZIP file for compression and encryption. 

6.5.2.4 Selecting recipients of the desired report

On the last page, you can add the recipient list. There are three ways to do so. You can 
add your recipients by clicking on the Add button which this is handy when doing for the 
first time or sending to only a few number of recipients. But you can also add them 
using the Import button which essentially allows you to import a text file with recipients 
email addresses on each line.

If this is not your first time adding your recipients, then you can take advantage of 
browse feature. Click on the Browse button in order to select the list of recipients from 
the list of already existing email addresses.
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Fig: Add the Mail Recipients

By choosing Finish, the scheduled report is done and your recipients should receive 
automated emails containing the corresponding report based on the scheduled set. 

6.5.3 Remove/Change Your Scheduled Report

If you intent to modify or remove your existing scheduled reports, you can simply 
choose Administration » Manage Scheduled Mail Report Jobs in order to modify 
existing scheduled mail jobs.
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Fig: Manager your scheduled Mail Jobs

Choose Remove in order to remove the scheduled report job or Change in order to 
modify its configuration.

6.6 Scheduled Report Export

JDisc Discovery allows automatic and scheduled exporting of any report into comma 
separated value or Microsoft Excel formatted files. Often time administrators want to 
share the most recent inventory information with their colleagues from other 
organizations. The simple CSV or Microsoft Excel formats makes the inventory 
information directly usable to IT personnel that are not used to run or do not have 
access to JDisc Discovery.

JDisc Discovery can automatically and scheduled export any table based report to a 
defined network location (e.g. a network share or a local directory on the discovery 
server).

6.6.1 Scheduling The Export

The scheduled report export preserves the column sort order and all selected filters. 
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Click the schedule report icon  from the report's toolbar to configure the automatic 
and scheduled export.

Fig: Schedule report export

And then from the opened menu select the Export report to disk option.

Fig: Export report options menu

The Scheduled Report Export configuration wizard allows adjusting these settings:

● The report export schedule

● The export options (such as export format, separator characters, etc.)

● The export destination (where to export the report to – e.g. a Windows share or 
a local folder on the discovery server)
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Configure the report export schedule in the Export Schedule group.

Fig: Report Export Schedule Panel

 Enter a descriptive name in the Export job name field. This name will help you to locate 
the report export job later on to modify parameters or to delete the job.

JDisc Discovery creates the report file name from the Base filename and appends  the  
time when exporting the report to file. This way you can keep multiple revisions of the 
report in the same directory.

The export options are

● Use multiple lines per device or item

● Create human readable values (e.g. 4.5Mb instead of 4718592 bytes)

● Keep a history of exported report files

● The export format (Comma Separated Values or Microsoft Excel)
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Fig: Export Configuration

The export destination designates where to store exported report files. Two storage 
destination options are available:

● A local directory on the discovery server (type Local Disk)

● A Windows network share (type Windows Shared Drive)

A user name and password are required to access a Windows networks share during 
the export.

Click the Test button to check if  the write access to the destination 
directory succeeds.

Enable the Use existing storage location option in the Export 
Destination group to export the report into an existing storage 
location. It is a good practice to use meaningful and descriptive 
names when creating new storage locations.
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Fig: Export Destination

6.6.2 Manage Report Export Jobs

You can manage your existing report export jobs from the Administration menu. Select 
Administration » Manage Scheduled Report Export Jobs to change  settings or delete 
existing report export jobs.

Fig: Open the Manage Scheduled Report Export Jobs DialogThis opens the Report Export  
Jobs dialog that displays all existing report export jobs. Select a report export job to and 
click Change to modify its settings or Remove to delete the report export job. Refer to 
chapter 6.6.1 for how to configure report export jobs.

6.6.3 Manage Storage Locations

Storage locations describe a directory and required access credentials to store reports. 
While  storage locations can be created when scheduling new report export jobs, you 
can also add, change and delete existing storage locations from the Manage Storage 
Locations dialog. 

6.7 Custom Reports

JDisc Discovery offers a variety of built-in reports. However, if these do not fit your 
needs, you can create your own reports using JDisc Discovery custom reporting 
feature. 

Custom reports can be created with three levels of visibility to other users:

● Private custom reports can only be executed by the creating user. 
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● Group custom reports can be executed by all users in the same group.

● Global custom reports can be executed by all users.

Custom reports can be organized in a hierarchy.

6.7.1 Create Custom Reports

Select Devices » Custom Reports to open the Custom Reports dialog.

Figure: Custom Reports Dialog

Click Add Folder to add a new folder to the report hierarchy.

Select a visibility category in the left panel of the dialog and click Add to create a new 
custom report. Enter a report name and description and click Next.
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Figure: Custom Report Name and Description

Select attributes to display in the custom report. Attributes are categorized into: 

● Device Attributes include Windows computer name, IP address, model, 
manufacturer, etc.

● Software attributes are comprised of operating system information, applications, 
application instances, patches, services, drivers, and processes.

● Firmware attributes include firmware information, such as BIOS name, version, 
etc.

● Hardware attributes represent hardware, such as processor, memory, disks, etc.

● Networking attributes include IP and MAC addresses, Windows network 
neighborhood and SNMP system group information.

● User attributes include logged on users, local users and logged on user history.

● Virtualization attributes include  virtual computers and physical host details.

● Attached Devices represent attributes of directly attached devices (such as 
monitors).

● Custom Attributes include the folder hierarchy and attribute names of  existing 
custom attributes.

Most of the attributes can serve as filter criteria to restrict the report to devices that 
match the specified criteria. If you do not enter any filter, all devices will be displayed in 
the custom.

Figure: Custom Report Attributes

Click Next to change the attribute order, if desired. Use Move up and Move down to 
change the attribute order as desired.
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Figure: Attribute Order

6.7.2 Run Custom Reports

Open the Custom Reports dialog from Devices » Custom Reports, select a report and 
click Run. The custom report will be displayed in a new window.

Figure: Run a Custom Report
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6.7.3 Modify Custom Reports

Open the Custom Reports dialog from Devices » Custom Reports, select a report and 
click Change to modify the report.

Figure: Change existing Reports

6.7.4 Remove Custom Reports

Open the Custom Reports dialog from Devices » Custom Reports, select a report and 
click Remove to delete the selected report.

6.7.5 Export And Import Custom Reports

Custom reports can be exported into XML formatted text files that can be imported into 
another JDisc Discovery installation. This way custom reports can be exchanged easily. 

Select a report to export, click Export, select a file name and click Save to export the 
report.
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Figure: Export a Custom Report

To import a custom report from file, select a visibility category (Private Reports, Group 
Reports, or Global Reports) in the left panel and click Import to select the custom report 
file to import.

Figure: Import a Custom Report
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7 WMI/WBEM Browser

7.1 Background

The WBEM (Web Based Enterprise Management) defines a set of standard to simplify 
network management in heterogeneous network environments. The WBEM protocol is 
based on the Common Information Model (CIM)  which defines the schema for your IT 
infrastructure.  WBEM is widely used on many Unix operating systems, but  also on 
infrastructure components such as routers or switches.

WMI (Windows  Management  Instrumentation) is Microsoft's technology  which is not 
compatible  with  WBEM,  but  widely  uses  the  same information  model.  WMI  is  the 
primary  source  for  hardware,  configuration  and  software  information  on  Windows 
computers.

7.2 CIM Object Model

The data model of WMI and WBEM consists of classes (comparable to classes in 
modern programming languages), instances and relations. Classes identify the 
information schema by defining attributes (state) and methods (behavior) of classes. 
For instance a class that defines a process might have the process id, the process 
name, the user starting the process and the command line parameters as properties. 
The method 'kill' let's users kill a specific process. Classes are usually derived from 
base classes and share their state and behavior.

WBEM and WMI organize classes in so called 'namespaces' that organize classes in a 
hierarchy. There exist also manufacturer specific namespaces. 

7.3 Browser

JDisc Discovery provides a WBEM/WMI browser that allows displaying raw WMI and 
WBEM information. The navigation tree in the browser's left panel displays the 
hierarchy of namespaces and all classes that belong to the selected namespace.

The browser supports the WMI on Windows as well as the WBEM 
protocol on Unix operating systems.
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Choose the Troubleshooting »  WBEM/WMI Browser context menu from within any 
device report to open the WBEM/WMI Browser for the selected device.

Figure: Open WMI/WBEM Browser from the device report's context menu
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This menu item opens the browser window.

Figure: WMI/WBEM browser window

When you expand a namespace from the WBEM/WMI Browsers' namespaces 
navigation panel will load all class definitions in the background. Depending on the 
connection speed and the number of classes existing in the namespace this might take 
a while .

Class definitions are represented by a capital 'C'. When you select a class the 
WBEM/WMI Browser will display all instances of the class in main content panel. Each 
instance is represented as a row within the instances table. The columns within the 
instances table represent the attributes of the instances' class definition. 

As in any other report, you can use the toolbar icons to export WBEM/WMI class 
instance information to Microsoft Excel or CSV formats.

The export icon offers a convenient way to export a classes or even namespaces 
(including or excluding subordinate namespaces). 

The export process creates a ZIP file contains a set of XML files and directories: 

• Directories represent  namespaces 

• XML files represent instances 

The WMI/WBEM export helps JDisc to extend its discovery capabilities alike SNMP 
walks from SNMP enabled devices. 
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8 Comparing Devices

JDisc Discovery can compare two devices and highlight the changes. Select two 
devices from any device report and select Compare »  Devices  to review the  changes.

Fig: Open the device compare dialog

This opens a new device details dialog that displays and highlights changes using 
different colors.

8.1 Comparing Scalar Reports

The figure below shows the device details compare dialog for two devices. Strikeout 
red colored text has been removed from the first device and green colored text has 
been added in the second device.
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Fig: Compare report of the operating system tab

8.1.1 Comparing Tables

When comparing table based reports, JDisc Discovery adds two columns at the 
beginning of the table to display the comparison status. JDisc Discovery displays

● identical rows using two check-marks

● missing rows in any of the two snapshot by omitting the check-mark in the 
respective columns.

● a red cross for rows that contain differences and highlights the cells that contain 
the differences using  red background color.
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Fig: Differences in a table based report
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9 Custom Attributes

Custom attributes extend JDisc Discovery's device data model to store additional 
device attributes that are not included in the standard device data model. Custom 
attributes can either be edited manually or filled by reading values from the Microsoft 
Windows registry or by executing commands, scripts or binaries on Windows and Unix 
computers. Custom attributes can be configured to preserve the  version history. JDisc 
Discovery then keeps track of custom attribute value changes and can display changes 
between different revisions.

9.1 Configure Custom Attributes

To configure custom attributes, open the Custom Attributes configuration dialog from 
Devices » Custom Attributes » Configuration. Custom attributes can be organized 
hierarchical allowing to group attributes that belong together.

Figure: Custom Attributes Configuration Dialog

Click:

● Add Folder to add a new folder into the hierarchy.

● Change to modify attributes..

● Remove to delete attributes or folders.

● Add to create a new custom attribute.

JDisc Discovery supports eight custom attribute types:
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● Text: text attributes can contain text of any size.

● Multiline text: multiline text attributes contain text of any size including line 
breaks.

● Date: attributes of type date contain date information.

● Time: attributes of type time contain time information.

● Enumeration: Define attributes having a fixed set of  values.

● Integer: a number

● Currency: a currency value

● Document: An imported document

To add a custom attribute:

● Choose a type from the drop-down box.

● Define a name and optionally enter a description.

● Optionally configure to automatically collect the custom attribute..

9.2 Edit Custom Attributes

To edit custom attributes 

● Select a device or multiple devices in any device aware report and open the 
Custom Attributes » Edit context menu. 

● Select the attribute or multiple attributes to edit and click Ok. 
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Figure: Edit Custom Attributes

You can edit multiple custom attributes for multiple devices at once!

The Edit Custom Attributes dialog is divided into two panels:

1. The device panel on the left side displays the selected devices.

2. The attribute panel on the right side displays selected attributes and values.

To enter attribute values:

● Select a cell in the attribute panel and edit the cell value.

● Click the save icon  to save your attribute value changes.

● Click the cross icon  to clear values of selected cells.

When an attribute value has been changed by a different user while 
you have been editing the same value, JDisc Discovery displays 
the conflicts and prompts whether to overwrite the other user's 
changes or to discard your changes.

9.3 Configure Custom Attribute Data Collection

In addition to manually editing custom attribute values, JDisc Discovery can 
automatically populate custom attribute values by 

● Reading the Microsoft Windows registry

● Executing binaries, scripts or system commands on target computers

Registry based custom attribute data collection is an easy way to collect attributes that 
JDisc Discovery does not collect out of the box. Moreover, JDisc Discovery can also 
populate custom attributes with command and script output.

A custom attributes' data collection method can be configured differently for each 
platform. You might use this flexibility to collect a computer's owner custom attribute 
from the registry on Windows computers but execute system commands on Unix. 

Data collections can be enabled or disabled individually.

A custom attributes' data collection method can be configured 
differently for each platform.  The platforms also include  the 
different  Windows versions such as Windows Vista or Windows 
XP.

- 237 -



Only text, multiline text and integer types can be automatically 
populated!

Select Keep change history for at least <n> days to enable the change history for a 
custom attribute. JDisc Discovery will keeps any number of revisions for at least <n> 
days. Older revisions will be deleted.

Select Automatically populate value to turn on automatic data collection for a custom 
attribute.

Figure: Enable automatic Data Collection

The Data Collection table displays configured data collection methods for the selected 
custom attribute. Click Add or Remove to add new or to remove data collection 
methods.

9.3.1 Configure Windows Registry Collection

Select Windows Registry from the Collection Method drop-down box. You can configure 
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registry keys and values on per  Windows operating system version. For convenience, 
you might select All Windows versions to configure the same registry key and value for 
all Windows versions.

Select a value from the HKEY drop-down box and enter a registry key. To read the 
default value, leave the value name blank . Otherwise enter the value name.

Figure: Windows Registry Custom Attribute Data Collection

9.3.2 Configure Remote Command Execution

Custom attribute data collection can use JDisc Discovery's remote login capabilities. 
When remote login is enabled,  JDisc Discovery can log on to target computers, 
optionally copy data collection scripts or binaries and finally execute commands. When 
a command has been executed successfully  the console output is captured and stored 
in the custom attribute. When a command fails to execute the console output appears 
in the Parsing Issues tab of the Device Details  dialog.

JDisc Discovery supports the following command execution types:

● Execute a built-in system shell command (such as ls on Unix, or dir on Windows) 
or a standard system command.

● Execute custom binaries (.exe files or binary executables for Unix)
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● Execute custom Visual Basic Scripts (.vbs)

● Execute custom Windows batch files (.bat)

● Execute custom Windows CMD files (.cmd)

● Execute custom Windows Powershell scripts (.ps1)

● Execute custom Unix shell scripts

To import scripts or binaries, open the Custom Attribute Data Collection dialog from 
Discovery » Custom Data Collection » Custom Attribute Data Collection. Imported 
binaries and scripts are stored in JDisc Discovery's database and will be preserved 
when archiving and restoring databases.

Figure: Configure Custom Attribute Data Collections

!!!!! BE CARFUL !!!!!

Always be careful when importing scripts or binaries into JDisc 
Discovery. Make sure your scripts and binaries are checked by 
your favorite anti-virus software. Otherwise you might risk to spread 
viruses over your network!

Make sure your homegrown scripts or executables run as fast as 
possible and do not hang in any case. Intensive testing is 
recommended before deploying your own scripts or binaries to your 
productive environment.

Each custom attribute data collection delays the discovery of a 
device while the script or binary runs (or until the timeout kills the 
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execution).

To add a new data collection script or binary supply these attributes:

● Type

● Name: The name that identifies this data collector.

● Description: An optional description.

● Filename: The file name that references the script or binary to be copied to 
target computers.

● Command line: The command line to execute after the binary or script has been 
transferred to target computers.

● Script code: This field contains the script code when one of the script options is 
selected.

Scripts and binaries can be used for custom attribute data collection. 

Select  Execute Command from for the Collection Method drop-down box. The Execute 
area displays configured custom data collections. For convenience, you can add new 
scripts or binaries by clicking Add .

Select the operating systems and data collectors as appropriate.

Figure: Configure Custom Attribute Data Collection
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When a script or binary is referenced by more than one custom 
attribute it will be copied only once to a target system saving 
network bandwidth and speeding up the discovery process.

The working directory for script or binary execution is a directory 
within the temporary session directory.

9.4 Review Custom Attributes

The Device Details dialog displays the values of all successfully  collected custom 
attribute from within the Custom Attributes tab. Furthermore custom attributes can be 
used from custom reports as any other device attribute.

9.4.1 Device Details

Open the Device Details dialog and select the Custom Attributes tab. The navigation 
tree in the left panel displays the custom attribute hierarchy. Select a folder to display 
custom attributes. Each custom attribute is identified by its name, its last modification 
date and in case of multiple revisions the number of revisions.
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Figure: Data Collection with 3 Revisions

Click the revisions link to open a new dialog displaying all collected revisions including 
heir values. Select a date to review the custom attribute value from that time.

Figure: Versions with Collection Data for Attribute 'Show Tech'

Select two revisions and click the Compare button  from the toolbar to open a new 
dialog displaying the differences between the two revisions. 

Changed lines are highlighted with red background. Missing lines on either side are 
highlighted with yellow background. You can use the toolbar buttons or these keyboard 
strokes:  F3  (next  diff)  and  Shift-F3  (previous  diff)  to  jump to  the  next  or  previous 
difference.
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Figure: Comparison Report

9.5 Import Custom Attributes

JDisc Discovery can import custom attributes from a comma separated text file.

9.5.1 The Import Process

An import file can contain values for exactly one custom attribute, but for multiple 
devices. Each line consists of a device identifier and the actual custom attribute value. 
The device identifier and the custom attribute value are separated by a comma (','). 

A device identifier can be one of the following:

● An IP4 address

● An IPv6 address

● A fully qualified hostname

● A Windows computername (with or without domain)

● A hostname (without full domain information)

● A device's serial number

JDisc Discovery attempts to match the device in the database that uniquely matches 
the device identifier in the import file. If JDisc Discovery finds more than a single device 
that matches the device identifier it will ignore the line from the import file and does not 
assign any value to the custom attribute.
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To import custom attribute values, select the Devices » Custom Attributes » Import... 
menu.

Figure: Import Custom Attribute values 

Select the custom attribute that you would like to import.

Figure: Select a Custom Attribute to import

Finally select the import file containing the device identifier and the custom attribute 
values. The import process opens a new report that displays if the import was 
successful or not for each line of the import file.
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Figure: Custom Attributes Import Result

Each line in the Custom Attributes Import result report displays detailed information 
about the import process.

9.5.2 Import File Format

Each line of the import file represents a single device and one custom attribute value. 
Custom attribute values must not span across a single line. Carriage return characters 
must be escaped using the '\n' character representation. JDisc Discovery supports 
different data types such as date, time, integer or text for  custom attribute values:

● A simple text field:
JDisc Discovery simply copies the value following the comma into the text field.

● A multiline text field
JDisc Discovery replaces all '\n' meta-characters with a new feed character, all 
'\r' meta-characters with a carriage return character and all '\t' meta-characters 
with a tabulator character.

● An integer field
JDisc Discovery parses integer values and stores them when parsed 
successfully.

● A date field
Date fields must comply to this format: 'YYYY-MM-DD'.

● A time field
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Time fields must comply to this format: 'HH:MM:SS'.

● An enumeration field
The value must be one of the valid enumeration values.
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10 Documents

JDisc Discovery can manage documents, such as device user manuals, support 
contracts, warranty information or any other document. You can import your documents 
into JDisc Discovery's database and assign them to devices.

 Documents are stored in JDisc Discovery's database and are included in a database 
archive when you use the archive and restore functions.

10.1 Manage Documents

Select Documents » Manage Documents to add, remove or change documents. You 
can use folders to organize your documents in folder hierarchy.

Figure: Manage Documents Dialog

Double-click the document icon to open the document. Click Export to export selected  
documents to the local computer's file system.

10.2 Use Documents

You can use custom attributes to assign documents to devices. Define a custom 
attribute of type Document to hold document assignments.
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Figure: Add a new Custom Attribute of Type Document

Open the context menu from any device report and select Custom Attributes » Edit to 
edit custom attributes. Select the new custom attribute and click ok.

Figure: Edit Document Custom Attributes

JDisc Discovery opens the document hierachy when editing a document attribute. 
Select the desired attribute and hit the Enter key.

Assigning documents to devices does not duplicate the document. 
JDisc Discovery creates an association between the document and 
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the device.

10.3 Documents And Reports

You can use custom attributes of type Document as any other custom attribute in your 
custom reports or in the device details dialog. 

Double-clicking the document icon in a custom report opens the associated document. 
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Figure: Custom Report with a Document

Double-click the document icon cell to open the document. Documents appear as any 
other custom attribute in the Custom Attributes tab.

Figure: Document Custom Attribute within the Device Details Dialog
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11 Simplified File Collection

JDisc Discovery can collect the content of ASCII files and can capture text output of 
command line applications on Windows and Unix platforms. When the Networking Add-
On is installed, JDisc Discovery can also collect configuration files and command 
output from many Cisco router and switches and HP ProCurve switches.

Open the Discovery Configuration dialog, select the Data Collection tab and select the 
File Collection tab from within the data collection tab..

JDisc Discovery supports two flavors of file collections:

1. Collect the content of ASCII files

2. Capture the output of command line tools

Figure: File Collections

The navigation tree in the right panel displays available operating system families. To 
review the current collection configuration, to add new collections or to remove existing 
collections, select one of the platforms in the navigation tree.  
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Each collection can be individually  enabled or  disabled.  Click  Enable or  Disable to 
toggle the configuration of selected collections.

11.1 Add New Collections

Select a platform from the navigation tree and click Add . Choose the desired platforms, 
configure history settings and select File collection to collect ASCII files on the hard 
drive or Command execution to capture a command's output. Enter a collection name 
and the full path name of the file or command. Enable Requires administrative access  
if the command or the file access requires privileged user rights.

Figure: Add Windows File Collection

JDisc Discovery supports the use of path variables such as 
%SystemRoot% when specifying the file name.

Always specify the full path name for file names or binaries!

11.2 Change Or Remove Collections

Select a platform from the navigation tree and click  Change or Remove to modify or 
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remove the collection. Note: Built-in collections cannot be deleted. However, the history 
configuration can be changed for built-in collections.
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12 Custom Software Discovery

JDisc Discovery already collects installed applications, patches, and services. However 
it only collects software that has been installed using the platforms standard installation 
procedure. Software that has  just been copied to a computer will not be detected.

JDisc Discovery can be enhanced by custom scripts or binaries to improve the software 
discovery of non-standard installed applications. Alike custom attribute collection, 
custom software discovery is also copying scripts or binaries to target computers and 
executes them remotely. When the console output matches a well-defined XML 
schema, JDisc Discovery parses the output and adds the contained software entries to 
the device.

JDisc Discovery's built in duplicate suppression takes care about 
removing duplicate software entries.

12.1 The XML Schema

Custom software scripts or binaries must conform to a well-defined XML schema. The 
XML schema consists of sections for applications (including application instances), 
patches and services.

For your reference: The XML schema definition is located in your installation directory 
within the 'schemas' directory. Refer to the schema file for a full description of all 
attributes!

The example below  shows a XML example output :

<?xml version="1.0" encoding="UTF-8"?>

<software>
  <app>
    <name>Demo Application</name>
    <version>1.5</version>
    <vendor>Demo Vendor</vendor>
    <path>C:\Program Files\Demo Vendor\Demo Application</path>
    <user>testuser</user>
    <installdate>2017-12-24</installdate>
    <license>
      <productid>123455</productid>
      <productkey>ABC-DEF-GHI</productkey>
      <expires>2019-12-24</expires>
      <status>licensed</status>
      <comment>This is a temporary license</comment>
    </license>
    <instance>
      <name>Demo Applciation Instance</name>
      <type>db</type>
    </instance>
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  </app>

  <patch>
    <name>Demo Patch</name>
    <vendor>Demo Vendor</vendor>
  </patch>

  <svc>
    <name>DemoServiceName</name>
    <dispname>Demo Service Display Name</dispname>
    <version>5.0</version>
    <vendor>Demo Vendor</vendor>
    <path> C:\Program Files\Demo Service</path>
    <binary> C:\Program Files\Demo Service\Demo.exe</binary>
    <params>-p -q -d</params>
    <startupmode>auto</startupmode>
    <status>running</status>
    <failure>none</failure>
  </svc>
</software>

Simply repeat the 'app', 'patch', or 'svc' sections to add multiple applications, patches 
and services if returned in a single data collection execution.

12.2 Import Software Data Collections

Open the Custom Software Data Collection dialog from Discovery » Custom Data 
Collection » Custom Software Data Collection  to import scripts or binaries . 

Figure: Configure Custom Software Data Collection

!!!!! BE CAREFUL (Part 2) !!!!!
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Always be careful when importing scripts or binaries into JDisc 
Discovery. Make sure your scripts and binaries have been checked 
by your favorite anti-virus software.  Otherwise you might risk to 
spread viruses over your network

Make sure your homegrown scripts or executables run as fast as 
possible and do not hang in any case. Intensive testing is 
recommended before deploying your own scripts or binaries to your 
productive environment.

Each custom attribute data collection delays the discovery of a 
device while the script or binary runs (or until the timeout kills the 
execution).

Make sure your scripts or binaries create the proper XML schema. 
Otherwise, the output will be rejected!

12.3 Configure Custom Software Data Collection Scripts

Custom collection scripts must be configured to be executed. Once, they are imported 
into JDisc Discovery, they can be configured in JDisc Discovery's discovery settings.

To configure custom software data collection scripts and binaries, open the Discovery 
Configuration dialog from Discovery » Configuration, select the Data Collection » 
Custom tab.  The Data Collection table displays configured custom software data 
collections. Enable or disable custom software data collections by using the check box. 
Select a custom software data collection and choose the operating system platforms for 
which the custom software data collection  is targeted.
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Figure: Configure Custom Software Data Collection

You can run multiple custom software data collection scripts for a 
operating system platform.
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13 Troubleshooting

The troubleshooting chapter explains how to troubleshoot JDisc Discovery if it does not 
discover devices properly or does not collect device details as expected.

The most common problems for incomplete discovery results are:

● Firewalls (either personal or network firewalls) blocking protocols. Refer to the 
protocols section 3.2.2 to review protocols and ports.

● Mis-configured/incorrect credentials prevent the discovery from identifying 
devices properly and collecting device details.

● Without credentials the discovery uses only anonymous protocols that do not 
require credentials and collect only basic device details.

● Mis-configured device type filters might exclude devices that should be 
discovered.

We keep all information provided by you confidential and will not disclose any 
information to other companies.

JDisc Discovery offers multiple ways to assist troubleshooting:

● The support ZIP file provides all information that our support engineers need to 
resolve product and device discovery issues.

● The Data Quality tab shows how well the devices within your network have been 
discovered and provides help on how to improve the data quality.

● The Discovery Protocol Status report displays the overall status of all protocols 
for a all devices. This report allows to quickly identify class problems, such as 
incorrect login credentials, or firewalls block network traffic. In addition to that, 
the Device Details dialog offers the Analyze » Protocols tab displays more 
detailed protocol information for a single device.

● The Discovery Log tab displays the sequence of all activity during the discovery 
of a device.

● The Diagnostics tab features a rule based expert system helping to identify 
issues that prevent a device from being discovered properly. Moreover the 
Diagnostics tab provides hints on how to resolve common problems.

● The Parsing Issues tab displays the output of system commands that could not 
be parsed correctly. This output can help JDisc Discovery's support to integrate 
new versions of system commands or operating system versions.

● The Unknown SNMP Devices report displays all devices supporting the SNMP 
protocol, which JDisc Discovery could not identify. The output of the Unknown 
SNMP Devices report can help JDisc Discovery's support to improve the 
discovery by adding those unknown devices to future versions of JDisc 
Discovery. 
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● The Unknown Telnet Banners report displays all devices supporting the telnet 
protocol, which JDisc Discovery could not identify. The output of the Unknown 
Telnet Banners report can help JDisc Discovery's support to improve the 
discovery by adding those unknown devices to future versions of JDisc 
Discovery. 

13.1 Support ZIP

The support ZIP function simplifies the interaction with JDisc's support and   provides a 
single file containing all server log files, discovery logs and related support information.

To accommodate to different problems, JDisc offers two support ZIP file types:

1. The product support ZIP

2. The device support ZIP

13.1.1 Product Support ZIP

The product support ZIP contains the license file and server log files. If your installation 
is not working properly, choose the Administration » Create Support ZIP menu item.

Figure: Create a product support ZIP file

From the Export Support ZIP dialog, choose a file name to store the product support 
ZIP file. Optionally you can enter a message for JDisc's support that describes the 
problem.
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Figure: Export a Support ZIP file

13.1.2 Device Support ZIP

The device support ZIP contains the license file, server log files, device details 
including the discovery log of selected devices. Choose the device support ZIP when 
you are facing issues when discovering one or multiple devices.

To create a device support ZIP, select one or more devices from a device report and 
chose the context menu item Create Support ZIP. The information in the device support 
ZIP is important for JDisc's support to resolve device specific discovery issues.

- 261 -



Figure: Create a device support ZIP file

Finally, from the Export Support ZIP dialog, choose a file name to store the device  
support ZIP file. Optionally you can enter a message for Company's support that 
describes the problem.

13.2 Data Quality Tab

Click on the Data Quality tab within the status area in order to review the current data 
quality. Red quality bars indicate a poor quality, yellow an fair quality and green a good 
data quality.
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Figure: Data Quality Tab

Follow the How to improve... link in the right area in order to open a new diagnostics 
report. This report displays a list of tasks on how to improve the data quality.
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Figure: Diagnostics Report

Use the context menu to open the list of devices to which a diagnostic entry applies or 
use the Explain option in order to get more details on the diagnostic entry.

13.3 Protocol Status

The protocol status is the first place to start troubleshoot discovery problems as it 
provides a quick overview of all devices. The protocols used by JDisc Discovery's 
depend on the device type and operating system. The Discovery Scenarios chapter 
presents an overview on how JDisc Discovery discovers the most important device 
types and operating systems and also explains the protocols.
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13.3.1 Discovery Protocol Status Report

Open the Discovery Protocol Status report from the Troubleshooting » Devices » 
Protocol Status menu. The Discovery Protocol Status report displays an overview of all 
protocols including the number of devices in the Success, Warning and Failed category. 
Select protocols and use the context menu to display all devices in any of the three 
categories.

Figure: Discovery Protocol Status Report

The protocol Warning category indicates configuration problems, such as missing 
passwords.

13.3.2 Device Discovery Protocol Report

The Device Protocol Status report displays all devices including the status of selected 
protocols. 
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Figure: Discovery Protocols Selection Dialog

Click Ok to open the Device Discovery Protocol Status report displaying the status of 
the selected protocols for all devices.

13.3.3 Single Device Protocol Status

From the Device Details dialog select Analyze » Protocols to displays the status of all 
protocols for the selected device.
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Figure: Protocols Tab displaying the Protocol Status for a single Device

13.4 Discovery Logs

JDisc Discovery logs discovery activity during discovery and data collection of a device. 
The discovery log also includes protocol information and data collected for each 
protocol.

From the Device Details dialog select Analyze » Discovery Log to display the discovery 
log.

The navigation tree in the left panel represents high-level discovery activity. Select an 
item in the left panel to limit the log output in the content panel. Errors and warnings are 
highlighted with icons.

13.5 Parsing Issues

To collect device details JDisc Discovery's discovery executes system commands on 
Unix and MAC OS X computers. System command output often depends on the 
operating system version. Though JDisc Discovery supports many operating system 
versions, system commands might generate output that JDisc Discovery cannot parse. 
To improve troubleshooting and support, JDisc Discovery stores unknown system 
command output in the database. This information helps JDisc Discovery's support to 
integrate new system command output formats into the product.
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From the Device Details dialog select Analyze » Parsing Issues to display unknown 
system command outputs.

13.6 Common Windows Computer Configuration Problems

Windows computer protocols, services and local policies can be configured in many 
ways to fit corporate security guidelines. However, some configuration settings, such 
as:

● Client for Microsoft Networks is not installed

● File and Printer Sharing for Microsoft Networks is not installed or disabled

● Simple File Sharing is enabled

● Sharing and security model for local accounts is set to Guest only – local users 
authenticate as Guest

● Server service is stopped

negatively affect JDisc Discovery's ability to accurately discover Windows computers. 

This section describes common configuration problems and symptoms to detect these 
problems based on JDisc Discovery's protocol status values.  

13.6.1 The Network Logon Service Was Not Started

Protocol Protocol Status

SMB authenticated An attempt was made to logon, but the network logon 
service was not started

Remote login admin An attempt was made to logon, but the network logon 
service was not started

WMI Access denied

Table: The network logon service was not started

Can be caused by these Windows configuration options:

● Client for Microsoft Networks is not installed

● Netlogon service is stopped

13.6.2 IO Failure And Network Path Was Not Found Symptoms

Protocol Protocol Status
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NetBIOS anonymous IO Failure

SMB anonymous The network path was not found

SMB authenticated The network path was not found

Remote login admin The network path was not found

Table: IO Failure and Network Path was Not found Symptoms

Can be caused by these Windows configuration options:

● File and Printer Sharing for Microsoft Networks is not installed or  disabled

● Server service is stopped

13.6.3 Logon Failure And Access Denied Symptoms

Protocol Protocol Status

SMB authenticated Logon failure: unknown user name or bad password

Remote login admin Logon failure: unknown user name or bad password

WMI Access denied

Table: Logon failure and Access Denied Symptoms

The symptoms might be caused by an invalid logon credential / password combination 
but also by these Windows configuration options:

● Simple File Sharing is enabled

● Sharing and security model for local accounts is set to Guest only – local users 
authenticate as Guest

13.7 Unknown SNMP Devices

JDisc Discovery supports many SNMP based devices. When manufacturer ship new 
devices the discovery's internal lookup tables and classes must be updated in order to 
support them. SNMP based devices that JDisc Discovery does not identify are 
classified as Unknown SNMP device. In such a case JDisc Discovery can access the 
device via SNMP but does not know how to discover the device including assigning a 
device type and model. 

You can help improving JDisc Discovery's device coverage when you send the 
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Unknown SNMP Devices report to JDisc Discovery's support. The development team 
can then add those unknown SNMP devices to future product versions. 

Open the Unknown SNMP Devices report from Troubleshooting » Devices » Unknown 
SNMP Devices.

Submit the Unknown SNMP Devices report to JDisc Discovery's 
support email-address. The development team can then add those 
unknown devices to future product versions.

In addition to the Unknown SNMP Devices report, SNMP walks can also help to 
support unknown device. 

To start a SNMP walk:

● Download the SNMP Walk Tool from our web site: 
www.jdisc.com/downloads/SnmpWalk.zip

● The SNMP walk tool already produces the output format that we need for our 
SNMP simulator.

● Run the tool according the instructions and submit the result file to our support. 
Depending on your corporate policies, you might send model, manufacturer and 
serial number along with the SNMP walk to JDisc Discovery's support email-
address. This additional information helps JDisc Discovery's support to better 
identify relevant SNMP variables in the SNMP walks.

Performing SNMP walks on unknown SNMP devices helps JDisc 
Discovery's support team to add these unknown devices in future 
product versions. Include (if possible) model, manufacturer and 
serial number. This helps JDisc Discovery's support to identify 
relevant SNMP variables in the SNMP walks.
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Figure: Unknown Telnet Banner Report

Submit the Unknown Telnet Banner report to JDisc Discovery's 
support email-address. The support team can then add this 
unknown telnet banner to future product versions.
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14 External Dependencies

The list of external depenencies and third party libraries is available from the About 
Dialog within the application.
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